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Introduction

Thanks for choosing Wingware’s Wing IDE! This manual will help you get started and
serves as a reference for the entire feature set of this product.

The manual is organized by major functional area of Wing IDE, including source code
editor, source code editor, project manager, source browser (Wing IDE Professional
only), and debugger.

Several appendices document the entire command set, provide pointers to resources and
tips for Wing and Python users, and list the full software license.

The rest of this chapter describes how to install and start using Wing IDE. If you hate
reading manuals, you should be able to get started by reading this chapter only.

Key Concepts
Throughout this manual, key concepts, important notes, and non-obvious features
are highlighted in the same way as this paragraph. If you are skimming only, look
for these marks.

1.1. Product Levels

This manual is for the Wing IDE Professional product level of the Wing IDE product
line, which currently includes Wing IDE Personal and Wing IDE Professional.

Wing IDE Professional is the full-featured Wing IDE product, and may be licensed for
commercial or non-commercial uses. Wing IDE Personal is for non-commercial use only
and contains a subset of the features found in Wing IDE Professional. Both products
are commercial products for sale from our website; Wing IDE Personal is not a free
download.

Wing IDE Professional and Wing IDE Personal are independent products and may be
installed at the same time on your system without interfering with each other.

11
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For a list of features that have been omitted from Wing IDE Personal, please refer to
http://wingware.com/wingide/features.

1.2. Licenses

Wing IDE is licensed per developer, and requires a separate license for each class of
operating system (Windows, Linux, or OS X) that is used by the developer.

For the full license text, see the Software License.
License Activation

To run for more than 10 minutes, Wing IDE requires activation of a trial or permanent
license. This system is designed to minimize the burden on legitimate user while elimi-

nating casual license sharing that threatens our ability to support further development
of Wing IDE.

An activation ties the license to the machine through a series of checks of the hardware
connected to the system. This information is never transmitted over the internet, instead
an SHA hash of some of the values is passed back and forth so that the machine will be
identifiable without us knowing anything specific about it.

The machine identity metrics used for activation are designed to be forgiving so that
replacing parts of your machine’s hardware or upgrading the machine will usually not
require another activation. By the same token, activating multiple times on the same
machine (for example if the activation file is lost) usually does not increase your activa-
tion count.

Licenses come with three activations by default and additional activations can be ob-
tained from the self-serve license manager or by emailing sales at wingware.com. As a
fall-back in cases of emergency where we cannot be contacted and you don’t have an
activation, Wing IDE will run for 10 minutes at a time without any license at all.

See Installing Your License for more information on obtaining and activating licenses.

1.3. Supported Platforms

This version of Wing IDE is available for Microsoft Windows, Linux, Mac OS X, and
some other operating systems for which contributed builds are available or where cus-
tomers are willing to compile the product from source code.

Microsoft Windows


http://wingware.com/wingide/features
http://wingware.com/license
mailto:sales@wingware.com
http://wingware.com/downloads/contrib
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Wing IDE supports Windows 2000, XP, and 2003 Server. Windows 95, 98, and ME are
not supported and will not work. Windows NT4 is not supported but may work with
[E5+ installed.

Linux/Intel

Wing IDE runs on Linux versions with glibc2.2 or later (anything roughly 3 years old
or newer; e.g. RedHat 7.1+, Mandrake 8.0+, SUSE 7.14, and Debian 3.0+).

On Suse, you may need to install the gmp and python packages, or install Python from
source, since Python is not installed by default here.

On Debian, you can convert the Wing IDE RPM into a Debian friendly package using the
alien module. Install alien-Package, then alien -d wingide-*.1386.rpm followed by
dpkg -i wingide-*.deb. Alternatively, use the Wing IDE tar file installer.

Mac OS X

Wing IDE runs on Mac OS X 10.3.9+. Wing IDE for OS X also requires an X11 Server
and Window Manager. For details see OS X Quick Start Guide.

Only Python 2.2 and later are supported for Mac OS X. OS X 10.3 and later come with
a standard version of Python already installed.

Other Platforms

Wing IDE can be compiled from source by customers wishing to use it on other operating
systems (such as Linux PPC, Free BSD, or Solaris). This requires a non-disclosure
agreement.

Some contributed builds of Wing IDE are available for other operating systems.

1.4. Supported Python versions

Before installing Wing, you must download and install Python 1.5.2, Python 2.0, Python
2.1, Python 2.2, Python 2.3, Python 2.4, or Python 2.5 if you do not already have one
of these on your machine.

On Windows, Python must be installed using one of the installers from the python.org
(or by building from source if desired).

On Linuz, most distributions come with Python. Installing Python is usually only
necessary on SUSE or a custom-built Linux installation.


http://wingware.com/pub/wingide/support/source-non-discl.pdf
http://wingware.com/pub/wingide/support/source-non-discl.pdf
http://wingware.com/downloads/contrib
http://python.org/1.5
http://python.org/2.0
http://python.org/2.1
http://python.org/2.1
http://python.org/2.2
http://python.org/2.3
http://python.org/2.4
http://python.org/2.5
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On SUSE Linux, you can install the gmp and python packages that come with your
distribution, or install from the materials available through the links given above.

On Mac OS X, Wing IDE only supports Python 2.2 and later.

1.5. Technical Support
If you have problems installing or using Wing IDE, please submit a bug report or feedback
using the Submit Bug Report or Submit Feedback items in Wing IDE’s Help menu.

Wingware Technical Support can also be contacted by email at support at wingware.com,
or online at http://wingware.com/support.

Bug reports can also be sent by email to bugs at wingware.com. Please include your OS
and product version number and details of the problem with each report.

If you are submitting a bug report via email, see Obtaining Diagnostic Output for
more information on how to capture a log of Wing IDE and debug process internals.
Whenever possible, these should be included with email-based bug reports.

1.6. Prerequisites for Installation

To run Wing IDE, you will need to obtain and install the following, if not already on
your system:

Prerequisites for all platforms:

e Downloaded or CD version of Wing IDE

e A supported version of Python

e A working TCP/IP network configuration (for the debugger; no outside access to
the internet is required)

Additional Prerequisities for Mac OS X:

e An X11 window server, such as Apple X11 for OS X (recommended) or XDarwin

e A window manager. Apple’s X11 Server includes one; other options include
OroborOSX


mailto:support@wingware.com
http://wingware.com/support
mailto:bugs@wingware.com
http://wingware.com/downloads
http://www.apple.com/macosx/features/x11/
http://www.xdarwin.org/
http://oroborosx.sourceforge.net/
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1.7. Installing

Before installing Wing IDE, be sure that you have installed the necessary prerequi-
sites. If you are upgrading from a previous version, see Upgrading first.

Note: On all platforms, the installation location for Wing IDE is referred to as
WINGHOME.

Windows 2000 and XP

Install Wing IDE by running the downloaded executable. Wing’s files are installed by
default in C:\Program Files\Wing IDE, but this location may be modified during in-
stallation. Wing will also create a User Settings Directory in the location appropriate
for your version of Windows. This is used to store preferences and other settings.

Linux (glibc 2.24)

To install the RPM, you must become root and type rpm -i wingide-2.1.4-
1.1386.rpm The IDE will be installed in /usr/lib/wingide2.1 with executables in
/usr/bin. The Wing IDE executable is /usr/bin/wing2.1.

To install the tar file, type tar -zxvf wingide-2.1.4-1-i386-1linux.tar.gz to ex-
tract from the tar archive. Then cd to the newly created directory wingide-2.1.4-1-
i386-1linux, type ./wing-install.py, and answer the questions to specify where the
program files and executable should go.

The Wing IDE executable is called wing2.1. You may have to modify your PATH
environment if you've installed the executables in a directory that isn’t already on your
path. You may also have to open a new shell or request that your shell rescan the disk
for executables (for example, with 'rehash’ under tcsh).

Wing will create a User Settings Directory in ~/.wingide2, which is used to store
preferences and other settings.

For more information, see the Linux installation details.
Mac OS X 10.3+

Wing IDE on Mac OS X requires that you first install an X11 Server. For details on
installing and running on OS X, see the OS X Quickstart.
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1.8. Running the IDE

For a quick introduction to Wing’s features, refer to the Wing IDE Quickstart Guide.
For a more gentle in-depth start, see the Wing IDE Tutorial.

On Windows, start Wing IDE from the Program group of the Start menu. You can
also start Wing from the command line with wing.exe (located inside WINGHOME).

On Linux/Unix, just execute wing2.1 (or wing located inside WINGHOME)

On Mac OS X, first launch your X11 Server. Then start Wing IDE by double
clicking on the app folder. If you launch Wing from the command line using Con-
tents/Mac0S/wing inside the Wing IDE app folder, then you may need to set your
DISPLAY environment variable.

1.9. Installing your License

To run for more than 10 minutes, Wing IDE requires a trial or permanent license and
the license needs to be activated (see the Licenses section for general information).
When Wing IDE is first started, you can obtain a trial licence, purchase a permanent
license, install & activate a permanent license, or use Wing for up to 10 minutes without
a license:

No License Found = O]

Wing is running without a valid license. You may now:
E‘ Obtain or extend a trial license
Purchase a permanent license

Install and activate a permanent license.
Enter license id:

10 minute emergency sessian

'@ continue| X Cancel

Trial Licenses

Trial licenses allow evaluation of Wing IDE for 10 days, with an option to extend the
evaluation twice for up to 30 days total. The most convenient way to obtain a trial
license is to ask Wing IDE to connect directly to TCP port 80 (http) on wingware.com.
In this case, Wing will attempt to connect and get everything it needs to run for 10 days.
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After the trial license is obtained, Wing will not attempt to connect to wingware.com
(or any other site) unless you submit feedback or a bug report through the Help menu.

Activate Trial license = Oj x|

» ConnectWing IDE directly to wingware.cam

Activate manually at http:/fwingware.com/factivate. You
will need your license id TNX3P-BFECQ-CYWS9-60F2T
and request code RLX24 LEWNK-DGEBEX-HMTWL. Then
enter the provided activation key here:

If you're unable or unwilling to connect Wing IDE directly to wingware. com, you can go
to http://wingware.com/activate and enter the license id and activation request number.
After entering this information, you will be given an activation key which you can enter
into Wing’s dialog box to complete the activation. This is exactly the same exchange of
information that occurs when Wing IDE connects directly to wingware.com to obtain a
trial license.

If you run into problems or need additional evaluation time, please email us at sales at
wingware.com.

Permanent Licenses

Permanent licenses and upgrades may be purchased in the online store at
http://wingware.com/store. Permanent licenses include free upgrades through the 2.*
version series. Wing IDE Professional licenses also allow access to the product source
code via http://wingware.com/downloads (requires signed non-disclosure agreement).

Activating on Shared Drives

When Wing is installed on a shared drive (for example a USB keydrive, or on a file
server), the User Settings Directory where the license activation is stored may be
accessed from several different computers.

In this case, Wing must be activated once on each computer. The resulting extra ac-
tivations will be stored as license.actl, license.act2, and so forth, and Wing will
automatically select the appropriate activation depending on where it is running.

Obtaining Additional Activations

If you run out of activations, you can use the self-serve license manager or email us at
sales at wingware.com to obtain additional activations on any legitimately purchased
license.


http://wingware.com/activate
mailto:sales@wingware.com
mailto:sales@wingware.com
http://wingware.com/store
http://wingware.com/downloads
http://wingware.com/pub/wingide/support/source-non-discl.pdf
http://wingware.com/license
mailto:sales@wingware.com
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1.10. User Settings Directory

The first time you run Wing, it will create your User Settings Directory automat-
ically. This directory is used to store your license, preferences, auto-save files, recent
lists, and other files used internally by Wing. If the directory cannot be created, Wing
will exit.

The settings directory is created in a location appropriate to your operating system.
The location is listed as your Settings Directory in the About Box accessible from
the Help menu.

These are the locations used by Wing;:
Linux/Unix -- ~/.wingide2 (a sub-directory of your home directory)

Windows -- In Wing IDE 2 within the Application Data folder. The location varies
by version of Windows. For Windows 2000 and XP running on c¢: with an English
localization the location is:

c:\\Documents and Settings\\${username}\\Application Data

Wing also creates a Cache Directory that contains the source analysis cache. This is
often but not always in the same location as the above. On Windows, this directory is
usually in the corresponding Local Settings area under Documents and Settings. This
directory is also listed in the About Box.

1.11. Upgrading

If you are upgrading Wing and have previously installed patch files by hand (rather
than with the integrated patch manager), see this additional information to avoid
problems during your upgrade.

If you are upgrading within the same minor version number of Wing (for example from
2.1 to 2.1.3) this will replace your previous installation. Once you have upgraded, your
previous preferences and settings should remain and you should immediately be able to
start using Wing.

If you are upgrading across major releases (for example from 2.0 to 2.1), this will install
the new version along side your old version of Wing.

To install an upgrade, follow the steps described in Installing
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1.11.1. Fixing a Failed Upgrade

In rare cases when upgrading within minor versions (for example 2.1 to 2.1.1), the
upgrade may fail to overwrite old files, resulting in random or bizarre behaviors and
crashing. The fix for this problem is to completely uninstall and manually remove
remaining files before installing the upgrade again.

Windows

To uninstall on Windows, run the Add/Remove Programs control panel to uninstall
Wing IDE. Then go into the directory where Wing was located and manually remove
any remaining folders and files.

Linux RPM

If you installed Wing IDE for Linux from RPM, issue the command rpm -e wingide.
Then go into /usr/lib/wingide and remove any remaining files and directories.

Linux Tar

If you installed Wing IDE for Linux from the tar distribution, find your Wing installation
directory and run the wing-uninstall script located there. Once done, manually remove
any remaining files and directories.

Mac OS X

On Mac OS X, you are simply copying from a disk image to create the installation.
Always remove your old installation first.

1.12. Advanced Installation

This section describes installation options for advanced users.

1.12.1. Installing Extra Documentation

If you are using Linux/Unix, the Python manual is not included in most installations,
so you may also wish to download and install local copies of these pages.

Place the top-level of the HTML formatted Python manual (where index.html is found)
into python-manual/#.# within your Wing IDE installation. Substitute for #.# the
major and minor version of the corresponding Python interpreter (for example, for the
Python 2.3.x manual, use python-manual/2.3).


http://docs.python.org/download.html
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Once this is done, Wing will use the local disk copy rather than going to the web when
the Python Manual item is selected from the Help menu.

1.12.2. Linux Installation Notes

On Linux, Wing can be installed from RPM or from tar archive. Use the latter if you
do not have root access on your machine or wish to install Wing somewhere other than
/usr/lib/wingide.

Installing from RPM:

Wing can be installed from an RPM package on RPM-based systems, such as RedHat
and Mandriva. To install, run rpm -i wingide-2.1.4-1.i386.rpm as root or use your
favorite RPM administration tool to install the RPM. Most files for Wing are placed
under the /usr/lib/wingide directory and a link for the wing2.1 command is placed
in the /usr/bin directory.

The installation location of Wing is referred to as WINGHOME. If you installed from RPM,
this will always be /usr/1ib/wingide.

Installing from Tar Archive:

Wing may also be installed from a tar archive. This can be used on systems that do not
use RPM, or if you wish to install Wing into a directory other than /usr/lib/wingide.
Unpacking this archive with tar -zxvf wingide-2.1.4-1-i386-linux.tar.gz will
create a wingide-2.1.4-1-i386-1inux directory that contains the wing-install.py
script and a binary-package.tar file.

Running the wing-install.py script will prompt for the location to install support files
for Wing (WINGHOME), and the location in which to create a symbolic link to wing2. 1.
These locations default to /usr/local/lib/wingide and /usr/local/bin, respectively.
The install program must have read/write access to both of these directories, and all
users running Wing must have read access to both.

The installation location of Wing is referred to as WINGHOME. If you installed from tar,
this will be the location you chose when you ran the installer.

Installing on Debian Linux:

You can convert the Linux RPM into a Debian friendly package using the alien module.
Here’s how:

1) Download the RPM package.
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2) Install the alien-Package, which is part of the Debian Package Collection. Use
apt-get, kpackage, aptitude, or other package manager to find and install it.

3) Change into the directory where the Wing IDE RPM is located and issue
the following command at the cmd prompt:

alien -d wingide-2.1.4-1.1386.rpm

4) A wingide-2.1.4-1.deb file can now be found in the same directory. To
install the this package issue the following command at the prompt:

dpkg -i wingide-2.1.4-1

This is a general technique that also works for other Linux RPMs.
Using System-wide GTK:

By default, Wing IDE runs with its own copy of GTK2 and does not pick up on the
system-configured theme. This is done to avoid problems and bugs sometimes brought
out by binary incompatibilities in GTK versions.

On Linux versions that include GTK version 2.6 or later, you can tell Wing IDE to use
the system-defined GTK2 by setting the System GTK preference or running with the
--system-gtk command line argument.

Using the system-wide GTK2 in this way generally works quite well but may result in
crashing or display bugs due to binary incompatibilities in GTK and related libraries.
If you set the preference and Wing fails to start, specify the —-private-gtk command
line option to override the preference.

Non-ascii File Paths on Older Linux Systems:

Some older Linux versions require setting the environment variable
G_BROKEN_FILENAMES before Wing IDE’s file open/save dialog will work properly
with file paths that contain non-ascii characters. The environment variable is already
set on some systems where it is needed but this is not always the case.

1.12.3. Source Code Installation

Source code is available to licensed users of Wing IDE Professional (non-evaluation
licenses only) who have completed a non-disclosure agreement. Upon receipt of this
agreement, you will be provided with instructions for obtaining and working with the
product source code.


http://wingware.com/pub/wingide/support/source-non-discl.pdf
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1.13. Removing Wing IDE

Windows

On Windows, use the Add/Remove Programs control panel, select Wing IDE and remove
it.

Linux/Unix
To remove an RPM installation on Linux, type rpm -e wingide.

To remove a tar archive installation on Linux/Unix, invoke the wing-uninstall script
in WINGHOME. This will automatically remove all files that appear not to have been
changed since installation, It will ask whether it should remove any files that appear to
be changed.

Mac OS X
To remove Wing from Mac OS X, just drag its application folder to the trash.
Removing a Patched Installation

If you previously applied patch files to your Wing installation, you may need to manually
remove remaining files and directories after uninstallation. In this case you should retain
the User Settings Directory, which contains license and preferences information.

1.14. Command Line Usage

Whenever you run wing2.1 from the command line, you may specify a list of files to
open. These can be arbitrary text files and a project file. For example, the following will
open project file myproject.wpr and also the three source files mysource.py, README,
and Makefile:

wing2.1 mysource.py README Makefile myproject.wpr

(on Windows, the executable is called wing.exe)

Wing determines file type by extension, so position of the project file name (if any) on
the command line is not important.

The following valid options may be specified anywhere on the command line:



23

--prefs-file -- Add the file name following this argument to the list of preferences files
that are opened by the IDE. These files are opened after the system-wide and default
user preferences files, so values in them override those given in other preferences files.

--new -- By default Wing will reuse an existing running instance of Wing IDE to open
files specified on the command line. This option turns off this behavior and forces
creation of a new instance of Wing IDE. Note that a new instance is always created if
no files are given on the command line.

--reuse -- Force Wing to reuse an existing running instance of Wing IDE even if there
are no file names given on the command line. This just brings Wing to the front.

--system-gtk -- (Posiz only) This option causes Wing to try to use the system-wide
install of GTK2 rather than its own version of GTK, regardless of any preference setting.
Running in this mode will cause Wing to pick up on system-wide theme defaults, but
may result in crashing or display problems due to incompatibilities in GTK and related
libraries.

--private-gtk -- (Posiz only) This option causes Wing to use it’s private copy of GTK2
and related libraries, regardless of any preference settings. Use of private GTK may result
in Wing not matching the system-wide theme, but also will avoid incompatibilities with
the system-wide GTK library.

--verbose -- (Posiz only) This option causes Wing to print verbose error reporting
output to stderr. On Windows, run console_wing.exe instead for the same result.

--display -- (Posiz only) Sets the X Windows display for Wing to run with. The display
specification should follow this argument, in standard format, e.g. myhost:0.0.

--use-winghome -- (For developers only) This option sets WINGHOME to be used
during this run. It is used internally and by developers contributing to Wing IDE. The
directory to use follows this argument.

--use-src -- (For developers only) This option is used to force Wing to run from Python
source files even if compiled files are present in the bin directory, as is the case after a
distribution has been built.

--orig-python-path -- (For developers only) This option is used internally to indicate
the original Python path in use by the user before Wing was launched. The path follows
this argument.

--squelch-output -- (For developers only) This option prevents any output of any kind
to stdout and stderr. Used on Windows to avoid console creation.
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1.15. Trouble-shooting

This section describes what to do if you are having trouble installing or using Wing IDE.

We welcome feedback and bug reports, both of which can be submitted directly
from Wing IDE using the Submit Feedback and Submit Bug Report items in
the Help menu, or by emailing us at support at wingware.com.

1.15.1. Trouble-shooting Failure to Start

If you are having trouble getting Wing to start at all, read through this section for
information on diagnosing the problem.

On OS X, Wing requires that you install and launch an X11 Server before starting
Wing IDE. See the OS X How-To for details.

On Windows, the user’s temporary directory sometimes becomes full, which prevents
Wing from starting. Check whether the directory contains more than 65,534 files. Some
versions of Acrobat Reader will leave large numbers of lock files in this directory. These
files are named Acrxxxx.tmp.

On Fedora Core 5 and other Linuxes with SELinux, Wing won’t start because
permissions are denied on one of the shared libraries needed by it. The solution is to
change into bin/2.4/external/pyscintilla2 and issue the following command:

chcon -t texrel_shlib_t _scintilla.so

On Linux, in some cases, Wing will not run with its own private GTK installation
because of incompatibilities with the system. To test this, run Wing with the --system-
gtk command line option after making sure your Linux system has the GTK packages
installed. If this works, you can set the Use System Gtk preference.

Note, however, that there are known problems running system-provided Qt emulation
when using the system GTK option. Some of these themes contain bugs that can cause
crashing. If you need to use the system GTK and experience crashes, we recommend
using a theme other than a Qt theme.

On Linux, if Wing fails to start after the Use System Gtk preference has been set,
use the —-private-gtk command line option to get Wing running again so that the
preference can be turned off.

To rule out problems with a project file or preferences, try renaming your User
Settings Directory and restart Wing. If this works, you can copy over files from the
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renamed directory one at a time to isolate the problem -- or email support at wingware
dot com for help.

Under a Windows terminal server, Wing may not be able to set up the environment
variables it uses internally and will not start up. In this case, you can get Wing to start
with the following commands:

set PYTHONOPTIMIZE=1
set PYTHONHOME=D:\Program Files\WingIDE\bin\PyCore
wing.exe

Alter PYTHONHOME according to the location at which you’ve installed Wing IDE.

In other cases, refer to Obtaining Diagnostic Output.

1.15.2. Issues on Microsoft Windows

Wing has a few problems and limitations on Microsoft Windows systems

1) A few of the demo shell extension COM objects from win32all can cause Wing to
crash if they are registered. The crash occurs when the file open, save, and add files to
project dialog boxes are used. These extensions may be disabled by using ShellExView
(http://www.snapfiles.com/get /shellexview.html) or a similiar program to find and dis-
able them. They can also be uninstalled by running the .py file with a --unregister
argument.

2) The nVidia Desktop Manager may cause the system to freeze on some versions of
Windows (apparently the card becomes very sluggish while the system CPU utilization
remains near 0%). The problem appears more frequently when using Wing in multi-
window modes but may occur in all cases. Disabling the manager prevents the freeze
from occuring.

There may be other display issues (such as failure to draw window contents when un-
minimizing from Windows task bar) specifically with some nVidia cards, even if the
desktop manager is disabled. We are investigating and plan to fix or work around this
problem in the future.

3) Windows drag-n-drop currently doesn’t work for transferring data (text or files) be-
tween Wing and either the Windows desktop or other applications.
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1.15.3. Trouble-shooting Failure to Debug

If you have trouble debugging with Wing IDE, select which of the following most closely
describes the problem you are seeing;:

e Debugging fails to start
e Debugger reports exceptions not seen outside Wing
e Debugger doesn’t stop on breakpoints

e Debugger doesn’t stop on exceptions

1.15.3.1. Failure to Start Debug

Wing may fail to start the debug process in certain cases. If this happens, it often helps
to try debugging a small test such as the following:

print "testl"
print "test2"

Use the Start / Continue command from the Debug menu to cause Wing IDE to
attempt to run only as far as the first line of your code. This rules out possible problems
caused by specific code.

Then check through the following common problems. For information on obtaining
additional information from the debug sub-system, refer to the Diagnostic Output
section:

1) Wing’s debugger uses a TCP /IP protocol to communicate with the IDE. Make sure
that TCP/IP is installed and configured on your machine. If you are running a custom-
built copy of Python, verify that the socket module is available.

2) If Wing says it can’t find Python or if you've got multiple versions of Python on your
system, make sure you've got your Project Properties set up to contain a valid inter-
preter (see Source / Show Analysis Stats menu item to verify that the right interpreter
is being found).

3) Enter any necessary PYTHONPATH for your debug process in Project Properties if not
already defined in the environment.

4) If you set PYTHONHOME or PYTHONPATH environment variables, these may cause the
debug process to fail if they do not match the particular Python interpreter that Wing
is launching. You can either change the interpreter used so it matches, or unset or alter
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these environment values from the outside or via Project Properties from the Project
menu.

PYTHONHOME is a problem in all cases when it doesn’t match the Python interpreter
reported in the Source menu’s Show Analysis Stats dialog.

PYTHONPATH is only a problem if it contains directories that are part of a Python in-
stallation. When this doesn’t match the interpreter version, this leads to import errors
because Python tries to import incompatible modules.

5) On Windows, check that you don’t have Hummingbird Socks Client installed on your
machine. Some versions and configurations of this product are known to incorrectly
route network packets in such a way that slows down the Wing IDE debugger enough
to make it time out during initialization.

6) All forms of the Python binary distribution (TAR, RPM, and Windows installer) are
known to have problems when a newer version of Python is installed directly over an
older one on disk.

In this case, most Python programs will appear to work fine outside of Wing IDE but
will not work within the Wing IDE debugger. This occurs because the debug support
code uses sockets and other functionality that is not necessarily exercised by your debug
program outside of the Wing debugger.

If you try to run a debug session in Wing IDE and it fails, you may be having this
problem. The following test script can be used to confirm that the problem exists in
your Python installation (although it is not known whether this script shows exceptions
in all cases where a corrupt Python installation is the cause of debugging problems):

import sys

print ’sys.version =’, sys.version

print ’sys.executable =’, sys.executable
print ’sys.version_info =’, sys.version_info
import socket

print ’socket =’, socket

print ’socket._socket =’, socket._socket
import select

print ’select =’, select

import cPickle

print ’cPickle =’, cPickle

To solve this problem, try uninstalling Python, manually removing any remaining files,
and installing again. Or install Python into a new location on disk.
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Once this is done, be sure to confirm that Wing is configured to use the new Python
installation from the Project Properties dialog in the Project menu and that the Show
Analysis Stats item in the Source menu displays the correct intepreter.

7) Wing’s debugger is unable to debug games written with pygame when they are
running in full screen mode. Use window mode instead. This is a problem also for other
IDEs; we have not yet investigated the cause.

1.15.3.2. Extra Debugger Exceptions

Wing’s debugger sometimes appears to reveal bugs that are not seen when running
outside of the debugger. This is a result of how Wing decides which exceptions should
be shown to the user -- it is inspecting exceptions as they are raised and making decisions
about whether or not the exception is unexpected or part of normal operation.

You can train Wing to ignore unwanted exception reports with the checkbox in the
Exceptions tool.

You can also change the way Wing reports debug process exceptions with the Exception
Reporting preference.

For more information, see Mlanaging Exceptions.

1.15.3.3. Failure to Stop on Exceptions

By default, Wing only stops on exceptions it thinks will be unhandled. If your code runs
within a catch-all try/except clause written in Python (as in some GUI main loops or
in an environment like Zope), Wing will not report any exceptions encountered in your
debug process, except if that exception leads the debug process to exit.

To get Wing to stop, you can set the Exception Reporting preference to A11 Im-
mediately. However, this often reports many other exceptions that happen internally
during normal operation.

An alternative is to recode your app to make your catch-all exception handler optional

as in the following example:

import os

# No handler when running in Wing’s debugger
if os.environ.has_key[’WINGDB_ACTIVE’]:
dosomething ()
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# Handle unexpected exceptions gracefully at other times
else:
try:
dosomething ()
except:
# handler here

Alternatively, add the following to your catch-all exception handler:

import os
if os.environ.has_key[’WINGDB_ACTIVE’]:
raise

This will terminate your debug process on the exception but will not always allow you
to inspect program state at the time that the exception is raised.

Note that environments such as wxPython, PyGTK, and others include catch-all han-
dlers for unexpected exceptions raised in the main loop, but those handlers are written
in C/C++ extension module code and thus will be reported correctly by Wing without
any modification to the handler.

1.15.3.4. Failure to Stop on Breakpoints or Show Source Code

The most common cause of failure to stop on breakpoints or to bring up source windows
while stopping or stepping through code is a mismatch between the file name that is
stored in the *.pyc file and the actual location of the *.py source file.

This can be caused by (1) not saving before you run in the debugger, (2) using partial
path names on PYTHONPATH or when invoking a script from the command line (the
partial path stored in the *.pyc file may become invalid if current directory changes),
(3) moving around the *.pyc file after they are created, or (4) using compileall.py to
create *.pyc files from source. The easiest way to solve this is to use only full paths on
PYTHONPATH and remove any suspect *.pyc files.

Wing may fail to stop when debugging a multi-threaded application, because the de-
bugger can currently only debug one thread at a time. If a breakpoint is reached in a
thread other than the main thread (or, if debugging an externally launched process, the
thread on which wingdbstub was imported), then the breakpoint is ignored.

Less common causes of this problem are (1) running Python with the -0 optimization
option, (2) running Python with psyco or other optimizer, (3) overriding the Python
__import__ routine, (4) adding breakpoints after you've started debugging an applica-
tion that spends much of its time in C/C++ or other non-Python code, and (5) on win32,
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using symbolic links to directories that contain your source code files (Posix platforms
handle symbolic links just fine).

For more information, see the Debugger Limitations section.

1.15.4. Obtaining Diagnostic Output

Wing IDE and your debug code run in separate processes, each of which can indepen-
dently be configured to collect additional diagnostic log information.

Diagnosing General IDE Problems

A quick way to diagnose problems seen while working with Wing IDE is to submit a
bug report from the Help menu. Please include a description of the problem and check
the Include error log checkbox so we can diagnose and fix the problem.

To diagnose other problems, such as failure to start, try looking at the file error-log
in your User Settings Directory.

Alternatively, run console_wing.exe (on Windows) or wing --verbose (on
Linux/Unix and OS X) from the command line to display diagnostic output.

Email this output to support at wingware.com along with your system version, version
of Wing IDE, and any other potentially relevant details.

Diagnosing Debugger Problems

To diagnose debugger problems, set preference Debug Internals Log File to a value
other than No logging and turn on preferences Use External Console and External
Console Waits on Exit. When you try again, Wing will display a debug console with
diagnostics.

Alternatively, copy wingdbstub.py out of your Wing IDE installation, set
WINGDB_LOGFILE environment variable to <stderr> or the name of a log file on disk
(or alter kLogFile inside wingdbstub.py), set the Enable Passive Listen preference
to True, and try launching the following script from the command line:

import wingdbstub
print "testl"
print "test2"

This prints diagnostic output that may be easier to capture in some cases.

Email this output to support at wingware.com. Include also the contents of the file
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error-log in your User Settings Directory , and also your system version, version
of Wing IDE, and any other potentially relevant details.

1.15.5. Speeding up Wing

Wing should present a responsive, snappy user interface even on relatively slow hardware.
In some cases, Wing may appear sluggish:

1) Try using a different Display Theme from preferences -- the pixmap manipulations
in Wing’s default themes sometimes fail to be accelerated on certain display hardware.
This is a bug we are working on fixing; it seems to appear on faster hardware more than
on slower hardware.

2) If you have nVidia desktop manager, disable it for Wing.

3) The first time you set up a project file, Wing analyses all source files for the source code
browser and auto-completion facilities. During this time, the browser’s class-oriented
views will display only the source constructs from files of which analysis information has
already been obtained. The user interface may also appear to be sluggish and Wing will
consume substantial amounts of CPU time.

To limit this effect in subsequent sessions, Wing stores its source analysis information
to disk in a cache within your User Settings Directory.

However, with large projects even reading this cache and checking files for updates may
take a while when Wing is first started. This process happens in the background after
launch and takes 7-15 seconds per 100,000 lines of code on a Celeron 400 processor
(almost not noticable on any modern hardware).

In all cases, Wing will eventually complete this process and should at that time consume
almost no CPU during normal editing and debugging.

4) In wxPython and other code that uses from xxx import * style imports, the auto-
completer may initially be slow to appear if it needs to process many hundreds of symbols.
This should only happen the first time it appears, however.

5) On Windows, if Wing is started while operating via Remote Desktop Connection,
performance is terrible, even after quitting the RDC session and working directly on the
machine that is running Wing. However, if Wing is started on the machine on which it
runs, performance is very lively on that machine and acceptable if switched to operating
via RDC without quitting Wing.

6) Some users have reported Hummingbird Socks Client for Windows to cause the de-
bugger to slow down substantially, apparently as a result of improperly routed TCP /IP
packets.
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7) If you are displaying Wing remotely via X11, try turning off anti-aliased fonts by
placing this file in ~/.fonts.conf on the display machine and then restarting the X
server.

1.15.6. Trouble-shooting Failure to Open Filenames Containing
Spaces

On Windows: When using Windows File Types or Open With to cause Python files
to be opened with Wing, some versions of Windows set up the wrong command line for
opening the file. You can fix this using regedt32.exe, regedit.exe, or similar tool to edit
the following registry location:

HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Applications\wing.exe\shell\open\command

The problem is that the association stored there is missing quotes around the %1 argu-
ment. It should instead read as follows:

"C:\Program Files\Wing IDE\bin\wing.exe" "%1" Jx

On Linux: KDE’s Konqueror has the same problem that file names passed on the
command line to applications bound to a file type are not enclosed with quotes, so the
command line is not parsed correctly. We do not currently have a work-around for this
problem.

1.15.7. Trouble-shooting Failure to Print

This section provides some hints to get printing working if it doesn’t work “out of the

7

box”.
On Windows

Wing has trouble printing with some printer drivers. One known issue is failure to
transfer the correct font to the printer. The symptom is correctly printed header and
footer but gibberish in the body of the source code. The problem can be solved in the
Advanced menu under Print Properties in Windows by changing TrueTypeFont from
“substitute with device font” to “download as soft font”.

On Linux

For Python files, Wing prints PDF formatted output directly to the printer. This does
not work on at least some Linux distributions and can be worked around by setting the
Print Spool Command preference to pdf2ps %s - | kprinter --stdin.
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Wing uses kprinter by default on Linux when it is present. Another problem on Linux
occurs when using a buggy version of kprinter, To rule that out, try pdf2ps %s - |
lpr or simply lpr %s instead for the Print Spool Command preference

Turning on the Print Python as Text preference may also solve some printing prob-
lems, although on some systems with plainer output for Python files. When this is
enabled, Python files are also passed through the the command given in the Text Print
Cmd preference instead of generating syntax highlighted PDF. In all cases, all non-
Python files are passed through this command.
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Customization

There are many ways to customize Wing IDE in order to adapt it to your needs or
preferences. This chapter describes the options that are available to you.

These are some of the areas of customization that are available:

e The content, layout, and look of the IDE windows can be configured

Many other options are available through preferences

The editor can run with different personalities such as Vim, Emacs, Visual
Studio, and Brief emulation

Keyboard shortcuts can be added, removed, or altered for any Wing command

File sets can be defined to control some of the IDE features

2.1. User Interface Options

Wing provides many options for customizing the user interface to your needs. Preferences
can be set to control the number and style of windows used when working with the IDE,
the layout of tools within windows, display text font, size, and color, the style and
content of the toolbar, and the overall look or “theme” (including white on black and
many others).

2.1.1. Windowing Policies

Wing IDE can run in a variety of windowing modes. This is controlled by the Win-
dowing Policy preference, which provides the following options:

35
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e Combined Tool Box and Editor Windows -- This is the default, in which
Wing opens a single window that combines the editor area with two tool box
panels.

e Separate Tool Box Windows -- In this mode, Wing IDE moves all the tools
out to a separate shared window.

e One Window Per Editor -- In this mode, Wing IDE creates one top-level win-
dow for each editor that is opened. Additionally, all tools are moved out to a
separate shared tool box window and the toolbar and menu are moved out to a
shared toolbar/menu window.

The windowing policy is used to describe the initial configuration and basic action of
windows in the IDE. When it is changed, Wing will reconfigure your projects to match
the windowing policy the first time they are used with the new setting.

However, it is possible to create additional IDE windows and to move editors and tools
out to another window or among existing windows without changing from the default
windowing policy. This is described below.

2.1.2. User Interface Layout

When working in the default windowing policy, Wing’s main user interface area consists
of two tool boxes (by default at bottom and right, but this can be altered in Prefer-
ences) and an area for source editors and integrated help.

Clicking on an already-active notebook tab will cause Wing to minimize the entire panel
so that only the notebook tabs are visible. Clicking again will return the tool box to its
former size. The F1 and F2 keys toggle between these modes. The command Maximize
Editor Area in the Tools menu (Shift-F2) can also be used to quickly hide both tool
areas and toolbar.

In other windowing modes, the tool boxes and editor area are presented in separate
windows but share many of the configuration options described below.

Configuring the Toolbar

Wing’s toolbar can be configured by altering the size and style of the toolbar icons in
the toolbar, and whether or not text is shown in addition to or instead of icons. This is
controlled with the Toolbar Icon Size and Toolbar Icon Style preferences.

Alternatively, the toolbar can be hidden completely with the Show Toolbar preference.

Configuring the Editor Area
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The options popup in the top right of the editor area allows for splitting and joining the
editor into multiple independent panels. These can be arranged horizontally, vertically,
or any combination thereof. When multiple splits are shown, all the open files within
the window are available within each split, allowing work on any combination of files
and /or different parts of the same file.

The options popup menu can also be used to change between tabbed editors and editors
that show a popup menu for selecting among files (the latter can be easier to manage
with large number of files) and to move editors out to a separate window or among
existing windows when multiple windows are open.

Configuring Tool Boxes

Each of the tool boxes can be also be split or joined into any number of sub-panels along
the axis of the notebook by clicking on the options drop down icon in the tab area of
the notebooks (right-clicking also works). The number of tool box splits Wing shows by
default depends on your monitor size.

The options pop down menu can also be used to duplicate tools, or move them around
among the splits or out to separate windows.

The size of each panel and the panel splits can also be altered by dragging on the dividers
between them.

All available tools are enumerated in the Tools menu, which will display the most recently
used tool of that type or will add one to your window at its default location, if none is
already present.

Creating Additional Windows

In addition to moving existing editors or tools to new windows, it is also possible to
create new tool windows (initially with a single tool) and new document windows (with
editor and toolbars if applicable to the selected windowing policy) from the Windows
menu.

Wing IDE will remember the state of all windows as part of your project file, so the
same window layout and contents will be restored in subsequent work sessions.

2.1.3. Altering Text Display

Wing tries to find display fonts appropriate for each system on which it runs, but many
users will want to customize the font style and size used in the editor and other user
interface areas. This can be done with the Source Code Font/Size and Display
Font /Size preferences.
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The color of text for some file types in the editor can be controlled with the Syntax
Formatting preference.

Note that the when the Source Code Background preference is set to a color other
than white, Wing will compute appropriately visible colors for text according to the
chosen background color.

The color used for text selection can also be controlled with the Text Selection Color
preference.

Changes in color preferences will often depend on the overall display theme that is
chosen, as described in the next section.

2.1.4. Setting Overall Display Theme

Wing is based on GTK2, a cross-platform user interface toolkit that provides customiz-
able themes, which control the overall look and feel of the user interface. Wing’s default
theme varies by platform (a Windows emulation theme is used on Windows, and an OS
X like theme on OS X) and can be changed with the Display Theme preference.

In most cases, the new theme will instantly be applied to Wing’s user interface. When
switching back to default settings, a restart may be needed in some cases, as indicated
by message dialog.

Some systems with slower graphics cards may not run as well using the more colorful
3D rendered themes. In this case, using the Gtk Default theme is the best option, as
it involves no extra graphics-level processing.

System GTK on Linux

On Linux systems with GTK 2.6 or later installed, it is possible to run Wing with
the system-wide GTK installation and system-defined themes. This is controlled with
the Use System GTK preference or the -—system-gtk or —-private-gtk command
line arguments. Wing works reasonably well with most 2.6.x GTK2 releases, but there
still may be problems resulting from version differences. If you have any problems with
Wing’s stability or are seeing display glitches, you should use the private gtk option.

2.2. Preferences

Wing has many preferences that control features of the editor, debugger, source browser,
project manager, and other tools.

To alter these, use the Preferences item in the Edit menu. This organizes all available
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preferences by category and provides access to documentation in tooltips that are dis-
played when mousing over the label area to the left of each preference. Any non-default
values that are selected through the Preferences Dialog are stored in the user’s pref-
erences file, which is located in the User Settings Directory.

2.2.1. Preferences File Layers

Wing’s preferences manager runs on a layered set of preferences files. An installation-
wide preferences file may be placed inside WINGHOME and individual users can override
these values by placing a preferences file in their User Settings Directory (or using
the Preferences GUI in Wing). The values given in the user-specific preferences file take
precedence over any values in the default WINGHOME/preferences file.

It is also possible to specify additional preferences files on the command line though the
—--prefs-file option. For example:

wing2.1 --prefs-file /path/to/myprefs

Any file specified in this way will override values stored in the per-user or installation-
wide preferences files.

2.2.2. Preferences File Format

While we recommend using the graphical preferences manager to alter preferences, some
users may wish to edit the underlying text files directly.

The preferences file format consists of a series of sections separated by bracketed head-
ers. Currently the only valid section is [user-preferences] and all other sections are
ignored. The body of each section is a sequence of lines, each of which is a name=value
pair.

Each preference name is in domain.preference form, where domain is the IDE sub-
system affected and preference is the name of the specific preference (for example,
edit.personality defines the source editor’s runtime personality).

Preference values can be any Python expression that will evaluate to a number, string,
tuple, list, or dictionary. Additionally, the constants true and false are defined and
supported as valid values. Long lines may be continued by placing a backslash (\\) at
the end of a line and comments may be placed anywhere on a line by starting them with
#.
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If you wish to write preferences files by hand, refer to the Preferences Reference for
documentation of all available preferences.

2.3. Editor Personalities

The default editor personality for Wing implements most common keyboard equivalents
found in a simple graphical text editor. This uses primarily the graphical user interface
for interacting with the editor and limits use of complex keyboard-driven command
interaction.

Emulation of Other Editors

The first thing any Vim, Emacs, Visual Studio, or Brief user will want to do is to
set the editor personality to emulate their editor of choice. This is done with the
Keyboard / Personality user interface preference.

Under the Vim and Emacs personalities, key strokes can be used to control most of the
editor’s functionality, using a textual interaction 'mini-buffer’ at the bottom of the editor
window where the current line number and other informational messages are normally
displayed.

It is also possible to add, alter, or remove individual keyboard command mappings within
each of these personalities. See Key Equivalents for details.

2.4. Key Equivalents

The command a key will invoke may be modified be selecting a different key map or by
specifying a custom key binding. A custom key binding will override any binding for a
particular key found in the keymap. Custom key bindings are set via the Custom Key
Bindings preference.

To add a binding, click the insert button and then press the key to be bound in the Key
field and enter the name of the command to invoke in the Command field.

Key bindings defined by default or overriden by this preference will be shown in any
menu items that implement the same command. In cases where a command is given
more than one key equivalent, only the last equivalent found will be displayed (although
both bindings will work from the keyboard).

Key maps
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Wing ships with several key equivalency maps found in WINGHOME, including
keymap.normal, keymap.emacs, keymap.vi, among others. These are used as default
key maps for the corresponding editor personalities.

For developing entirely new key bindings or debugging key bindings, it is possible to
create a custom key equivalency map and use it as your default map through Key Map
File preference. This is not recommended for casual users, since completely replacing
the default key maps will require manual tracking of changes in commands across Wing
versions.

In a key map file, each key equivalent is built from names listed in the Key Names
section. These names can be combined as follows:

1) A single unmodified key is specified by its name alone, for example
’Down’ for the down arrow key.

2) Modified keys are specified by hyphenating the key names, for ex-
ample ’shift-Down’ for the down arrow key pushed while shift is
held down. Multiple modifiers may also be specified, as in ’ctrl-
shift-Down’.

3) Multi-key combinations can be specified by listing multiple key
names separated by a space. For example, to define a key equiv-
alent that consists of first pushing ctrl-x and then pushing the a
key by itself, use ’ctrl-x a’ as the key sequence.

The command portion of the key equivalency definition may be any of the commands
listed in section Command Reference. Use None to remove the given key equivalent
entirely.

Specifying a key binding that already exists in the default key binding simply replaces
that binding with your override.

Examples

Here is an example of adding a key binding for a command. If the command already
has a default key binding, both bindings will work:

’Ctrl-X P’: ’debug-attach’
This example removes a key equivalent entirely:
’Ctrl-C Ctrl-C’: None

These can be combined to changes the key binding for a command without retaining its
default key binding:
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’Ctrl-C Ctrl-C’: None
’Ctrl-G’: ’debug-continue’

Wing always retains only the last key binding for a given key combination. This example
binds Ctrl-X to ’quit” and no other command:

’Ctrl-X’: ’debug-stop’
’Ctrl-X’: ’quit’

2.4.1. Key Names

(1) Key modifiers supported by Wing IDE for key bindings are:

e Ctrl -- Either control key.

e Shift -- Either shift key. This modifier is ignored with some key names, as indicated
below.

e Alt -- Not recommended for general use since these bindings tend to conflict with
menu accelerators and operating system or window manager operations.

e Command -- Macintosh command / apple key. This may be mapped to other

keys on other systems, but is intended for use on the Macintosh.

On Linux and OS X it is possible to remap the function of the Control, Alt, command,
and windows keys. In those cases, the Ctrl and Alt modifiers will refer to the keys
specified in that mapping.

(2) The digit keys and core western alphabet keys are specified as follows:

O? 17 27 37 47 57 67 77 87 97 A7 B? C7 D? E7 F7 G’ H7 I7 J? K7L7 M7 N? O7P7 Q? R‘? S7 T? U?
V., W, X, Y, Z,

(3) Most punctuation can be specified but any Shift modifier will be ignored since these
keys can vary in location on different international keyboards. Allowed punctuation
includes:

frrte# s ex () -_+=01{}r\N ;2" /70>, <

(4) These special keys can also be used:
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Escape, Space, BackSpace, Tab, Linefeed, Clear, Return, Pause, Scroll_Lock, Sys_Req,
Delete, Home, Left, Up, Right, Down, Prior, Page_Up, Next, Page_Down, End, Be-
gin, Select, Print, Execute, Insert, Undo, Redo, Menu, Find, Cancel, Help, Break,
Mode_switch, script_switch, Num_Lock,

F1, F2, F3, F4, F5, F6, F7, F8, F9, F10, F11, L1, F12, 1.2, F13, L3, F14, L4, F15, L5,
F16, L6, F17, L7, F18, L8, F19, 1.9, F20, L10, F21, R1, F22, R2, F23, R3, F24, R4, F25,
R5, F26, R6, F27, R7, F28, RS, F29, R9, F30, R10, F31, R11, F32, R12, F33, R13, F34,
R14, F35, R15,

(5) For equivalents that work with the mouse buttons, use these:

Pointer_Left, Pointer_Right, Pointer_Up, Pointer_Down, Pointer_UpLeft,
Pointer_UpRight,  Pointer_DownLeft,  Pointer_DownRight,  Pointer_Button_DAflt,
Pointer_Buttonl, Pointer_Button2, Pointer_Button3, Pointer_Button4,
Pointer_Buttonb,  Pointer_DblClick_Dflt,  Pointer_DblClickl,  Pointer_DblClick2,
Pointer_DblClick3, Pointer_DblClick4, Pointer_DblClick5, Pointer_Drag_DAflt,
Pointer_Dragl, Pointer_Drag2, Pointer_Drag3, Pointer_Drag4, Pointer_EnableKeys,
Pointer_Accelerate, Pointer_DfltBtnNext, Pointer_DfltBtnPrev,

(6) Keypad keys are specified like this:

KP_Left, KP_Right, KP_Up, KP_Down, KP_Home, KP_Page_Up, KP_Page_Down,
KP_End, KP_Insert, KP_Delete, KP_0, KP_1, KP_2, KP_3, KP_4, KP_5, KP_6, KP_7,
KP_8, KP_9,

(7) These will also work but ignore the Shift modifier since they tend to appear in
different locations on international keyboards:

KP_Space, KP_Tab, KP_Enter, KP_F1, KP_F2, KP_F3, KP_F4, KP_Prior, KP_Next,
KP_Begin, KP_Insert, KP_Delete, KP_Equal, KP_Multiply, KP_Add, KP_Separator,
KP_Subtract, KP_Decimal, KP_Divide,

exclam, quotedbl, numbersign, dollar, percent, ampersand, apostrophe, quoteright,
parenleft, parenright, asterisk, plus, comma, minus, period, slash, colon, semicolon, less,
equal, greater, question, at, bracketleft, backslash, bracketright, asciicircum, underscore,
grave, quoteleft, braceleft, bar, braceright,

EuroSign, EcuSign, ColonSign, CruzeiroSign, FFrancSign, LiraSign, MillSign, NairaSign,
PesetaSign, RupeeSign, WonSign, NewSheqelSign, DongSign,

Many other key names are available for use on international or special purpose keyboards:

asciitilde, nobreakspace, exclamdown, cent, sterling, currency, yen, brokenbar, section,
diaeresis, copyright, ordfeminine, guillemotleft, notsign, hyphen, registered, macron,
degree, plusminus, twosuperior, threesuperior, acute, mu, paragraph, periodcentered,
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cedilla, onesuperior, masculine, guillemotright, onequarter, onehalf, threequarters, ques-
tiondown,

leftradical, topleftradical, horizconnector, topintegral, botintegral, vertconnector,
topleftsgbracket, botleftsqbracket, toprightsqbracket, botrightsqbracket, topleftparens,
botleftparens, toprightparens, botrightparens, leftmiddlecurlybrace, rightmiddlecurly-
brace, topleftsummation, botleftsummation, topvertsummationconnector, botvert-
summationconnector, toprightsummation, botrightsummation, rightmiddlesummation,
lessthanequal, notequal, greaterthanequal, integral, therefore, variation, infinity, nabla,
approximate, similarequal, ifonlyif, implies, identical, radical, includedin, includes,
intersection, union, logicaland, logicalor, partialderivative, function, leftarrow, upar-
row, rightarrow, downarrow, blank, soliddiamond, checkerboard, ht, ff, cr, If, nl, vt,
lowrightcorner, uprightcorner, upleftcorner, lowleftcorner, crossinglines, horizlinescanl,
horizlinescan3, horizlinescanb, horizlinescan7, horizlinescan9, leftt, rightt, bott, topt,
vertbar, emspace, enspace, em3space, emdspace, digitspace, punctspace, thinspace,
hairspace, emdash, endash, signifblank, ellipsis, doubbaselinedot, onethird, twothirds,
onefifth, twofifths, threefifths, fourfifths, onesixth, fivesixths, careof, figdash, leftangle-
bracket, decimalpoint, rightanglebracket, marker, oneeighth, threeeighths, fiveeighths,
seveneighths, trademark, signaturemark, trademarkincircle, leftopentriangle, rightopen-
triangle, emopencircle, emopenrectangle, leftsinglequotemark, rightsinglequotemark,
leftdoublequotemark, rightdoublequotemark, prescription, minutes, seconds, latincross,
hexagram, filledrectbullet, filledlefttribullet, filledrighttribullet, emfilledcircle, emfille-
drect, enopencircbullet, enopensquarebullet, openrectbullet, opentribulletup, opentribul-
letdown, openstar, enfilledcircbullet, enfilledsqgbullet, filledtribulletup, filledtribullet-
down, leftpointer, rightpointer, club, diamond, heart, maltesecross, dagger, doubledag-
ger, checkmark, ballotcross, musicalsharp, musicalflat, malesymbol, femalesymbol,
telephone, telephonerecorder, phonographcopyright, caret, singlelowquotemark, dou-
blelowquotemark, cursor, leftcaret, rightcaret, downcaret, upcaret, overbar, downtack,
upshoe, downstile, underbar, jot, quad, uptack, circle, upstile, downshoe, rightshoe,
leftshoe, lefttack, righttack,

Multi_key, Codeinput, SingleCandidate, MultipleCandidate, PreviousCandidate, Kanji,
Muhenkan, Henkan_Mode, Henkan, Romaji, Hiragana, Katakana, Hiragana_Katakana,
Zenkaku, Hankaku, Zenkaku Hankaku, Touroku, Massyo, Kana_Lock, Kana_Shift,
Eisu_Shift, Fisu_toggle, Kanji_Bangou, Zen_Koho, Mae_Koho,

ISO_Lock, ISO_Level2_Latch, ISO_Level3_Shift, ISO_Level3_Latch, ISO_Level3_Lock,
ISO_Group_Shift, ISO_Group_Latch, ISO_Group_Lock, ISO_Next_Group,
ISO_Next_Group_Lock, ISO_Prev_Group, ISO_Prev_Group_Lock, ISO_First_Group,
I[SO_First_Group_Lock, ISO_Last_Group, ISO_Last_Group_Lock, ISO_Left_Tab,
ISO_Move_Line_Up, ISO_Move_Line_Down, ISO_Partial_Line_Up, ISO_Partial_Line_Down,
[SO_Partial _Space_Left, I[SO_Partial_Space_Right, [SO_Set_Margin_Left,
I[SO_Set_Margin_Right, ISO_Release_Margin_Left, I[SO_Release_Margin_Right,
ISO_Release_Both_Margins, [SO_Fast_Cursor_Left, [SO_Fast_Cursor_Right,



45

[SO_Fast_Cursor_Up, [SO_Fast_Cursor_Down, ISO_Continuous_Underline,
ISO_Discontinuous_Underline, ISO_Emphasize, [SO_Center_Object, ISO_Enter

dead_grave, dead_acute, dead_circumflex, dead_tilde, dead_macron, dead_breve,
dead_abovedot, dead_diaeresis, dead_abovering, dead_doubleacute, dead_caron,
dead_cedilla, dead_ogonek, dead_iota, dead_voiced_sound, dead_semivoiced_sound,

dead_belowdot,

First_Virtual_Screen, Prev_Virtual_Screen, Next_Virtual_Screen, Last_Virtual_Screen,
Terminate_Server, AccessX_Enable, AccessX_Feedback_Enable, RepeatKeys_Enable,
SlowKeys_Enable, BounceKeys_Enable, StickyKeys_Enable, MouseKeys_Enable,
MouseKeys_Accel_Enable, Overlayl_Enable, Overlay2_Enable, AudibleBell _Enable,
Pointer_Left, Pointer_Right, Pointer_Up,

_3270_Duplicate,  _3270_FieldMark,  _3270_Right2, 3270_Left2,  _3270_Back-
Tab, _3270_EraseEOF, _3270_Eraselnput, 3270_Reset, _3270_Quit, _3270_PAl,
_3270_PA2, _3270_PA3, _3270_Test, 3270_Attn, _3270_CursorBlink, _3270_AltCur-
sor, _3270_KeyClick, 3270_Jump, _3270_Ident, _3270_Rule, _3270_Copy, _3270_Play,
_3270_Setup, 3270_Record, _3270_ChangeScreen, _3270_DeleteWord, _3270_ExSelect,
3270_CursorSelect, _3270_PrintScreen, __3270_Enter,

Agrave, Aacute, Acircumflex, Atilde, Adiaeresis, Aring, AE, Ccedilla, Egrave, Ea-
cute, Ecircumflex, Ediaeresis, Igrave, Iacute, Icircumflex, Idiaeresis, ETH, Eth, Ntilde,
Ograve, Oacute, Ocircumflex, Otilde, Odiaeresis, multiply, Ooblique, Ugrave, Uacute,
Ucircumflex, Udiaeresis, Yacute, THORN, Thorn, ssharp, agrave, aacute, acircumflex,
atilde, adiaeresis, aring, ae, ccedilla, egrave, eacute, ecircumflex, ediaeresis, igrave, ia-
cute, icircumflex, idiaeresis, eth, ntilde, ograve, oacute, ocircumflex, otilde, odiaeresis,
division, oslash, ugrave, uacute, ucircumflex, udiaeresis, yacute, thorn, ydiaeresis, Ao-
gonek, breve, Lstroke, Lcaron, Sacute, Scaron, Scedilla, Tcaron, Zacute, Zcaron, Zabove-
dot, aogonek, ogonek, Istroke, lcaron, sacute, caron, scaron, scedilla, tcaron, zacute,
doubleacute, zcaron, zabovedot, Racute, Abreve, Lacute, Cacute, Ccaron, Eogonek,
Ecaron, Dcaron, Dstroke, Nacute, Ncaron, Odoubleacute, Rcaron, Uring, Udoubleacute,
Tcedilla, racute, abreve, lacute, cacute, ccaron, eogonek, ecaron, dcaron, dstroke, nacute,
ncaron, odoubleacute, udoubleacute, rcaron, uring, tcedilla, abovedot, Hstroke, Hcir-
cumflex, labovedot, Gbreve, Jcircumflex, hstroke, hcircumflex, idotless, gbreve, jcircum-
flex, Cabovedot, Ccircumflex, Gabovedot, Gcircumflex, Ubreve, Scircumflex, cabovedot,
ccircumflex, gabovedot, gcircumflex, ubreve, scircumflex, kra, kappa, Rcedilla, Itilde,
Lcedilla, Emacron, Gceedilla, Tslash, rcedilla, itilde, lcedilla, emacron, gcedilla, tslash,
ENG, eng, Amacron, Iogonek, Eabovedot, Imacron, Ncedilla, Omacron, Kcedilla, Uo-
gonek, Utilde, Umacron, amacron, iogonek, eabovedot, imacron, ncedilla, omacron,
kecedilla, uogonek, utilde, umacron, OE, oe, Ydiaeresis, overline,

kana_fullstop, kana_openingbracket, kana_closingbracket, kana_comma,
kana_conjunctive, kana_middledot, kana_WO, kana_a, kana_i, kana_u, kana_e, kana_o,
kana_ya, kana_yu, kana_yo, kana_tsu, kana_tu, prolongedsound, kana_A, kana_I, kana_U,
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kana_FE, kana_O, kana_KA, kana_KI, kana_ KU, kana_KE, kana_KO, kana_SA, kana_SHI,
kana_SU, kana_SE, kana_SO, kana TA, kana CHI, kana_TI, kana TSU, kana_TU,
kana_TE, kana_TO, kana NA, kana NI, kana_ NU, kana NE, kana_NO, kana HA,
kana_HI, kana_FU, kana_HU, kana_HE, kana HO, kana_MA, kana_MI, kana MU,
kana_ME, kana_MO, kana_YA, kana_YU, kana_YO, kana_RA, kana_RI, kana_RU,
kana_RE, kana_RO, kana_WA, kana_N, voicedsound, semivoicedsound, kana_switch,

Arabic_comma, Arabic_semicolon, Arabic_question_mark, Arabic_hamza, Ara-
bic_maddaonalef, Arabic_hamzaonalef, Arabic_hamzaonwaw, Arabic_hamzaunderalef,
Arabic_hamzaonyeh, Arabic_alef, Arabic_beh, Arabic_tehmarbuta, Arabic_teh, Ara-
bic_theh, Arabic_jeem, Arabic_hah, Arabic_khah, Arabic_dal, Arabic_thal, Arabic_ra,
Arabic_zain, Arabic_seen, Arabic_sheen, Arabic_sad, Arabic_dad, Arabic_tah, Ara-
bic_zah, Arabic_ain, Arabic_ghain, Arabic_tatweel, Arabic_feh, Arabic_qaf, Arabic_kaf,
Arabic_lam, Arabic_meem, Arabic_noon, Arabic_ha, Arabic_heh, Arabic_waw, Ara-
bic_alefmaksura, Arabic_yeh, Arabic_fathatan, Arabic_dammatan, Arabic_kasratan,
Arabic_fatha, Arabic_.damma, Arabic_kasra, Arabic_shadda, Arabic_sukun, Ara-
bic_switch,

Serbian_dje, Macedonia_gje, Cyrillic_io, Ukrainian_ie, Ukranian_je, Macedo-
nia_dse, Ukrainian_i, Ukranian_i, Ukrainian_yi, Ukranian_yi, Cyrillic_je, Serbian_je,
Cyrillic_lje, Serbian_lje, Cyrillic_nje, Serbian_nje, Serbian_tshe, Macedonia_kje,
Ukrainian_ghe_with_upturn, Byelorussian_shortu, Cyrillic.dzhe, Serbian_dze, nu-
merosign, Serbian_DJE, Macedonia_GJE, Cyrillic_1O, Ukrainian_[E, Ukranian_JE,
Macedonia_DSE, Ukrainian_I, Ukranian_I, Ukrainian_YI, Ukranian_YI, Cyrillic_JE,
Serbian_JE, Cyrillic_.LJE, Serbian LJE, Cyrillic. NJE, Serbian NJE, Serbian TSHE,
Macedonia_ KJE, Ukrainian GHE_WITH_UPTURN, Byelorussian SHORTU, Cyril-
lic. DZHE, Serbian DZE, Cyrillic_yu, Cpyrillic_a, Cyrillic_be, Cyrillic_tse, Cyrillic_de,
Cyrillic_ie, Cyrillic_ef, Cyrillic_ghe, Cyrillic_ha, Cyrillic_i, Cyrillic_shorti, Cyrillic_ka,
Cyrillic_el, Cyrillic_em, Cyrillic_en, Cyrillic_o, Cyrillic_pe, Cyrillic_ya, Cyrillic_er, Cyril-
lic_es, Cyrillic_te, Cyrillic_u, Cyrillic_zhe, Cyrillic_ve, Cyrillic_softsign, Cyrillic_yeru,
Cyrillic_ze, Cyrillic_sha, Cyrillic_e, Cyrillic_shcha, Cyrillic_che, Cyrillic_hardsign,
Cyrillic_.YU, Cyrillic_A, Cyrillic.BE, Cyrillic_.TSE, Cyrillic.DE, Cyrillic_LIE, Cyril-
lic.EF, Cyrillic.GHE, Cyrillic.ZHA, Cyrillic_I, Cyrillic. SHORTI, Cyrillic. KA, Cyril-
lic.EL, CyrilliccEM, Cyrillic_ZEN, Cyrillic_O, Cyrillic_.PE, Cyrillic_ZYA, Cyrillic_ZER,
Cyrillic_ES, Cyrillic_TE, Cyrillic_U, Cyrillic.ZZHE, Cyrillic_.VE, CyrillicZ.SOFTSIGN,
Cyrillic.YERU, Cyrillic_.ZE, Cyrillic.SHA, Cyrillic_E, Cyrillic. SHCHA, Cyrillic.CHE,
CyrilliccHARDSIGN,

Greek_ALPHAaccent, Greek EPSILONaccent, Greek ETAaccent, Greek IOTAaccent,

Greek_10TAdiaeresis, Greek_ OMICRONaccent, Greek_UPSILONaccent,
Greek_UPSILON(dieresis, Greek_ OMEGAaccent, Greek_accentdieresis,
Greek_horizbar, Greek_alphaaccent, Greek_epsilonaccent, Greek_etaaccent,

Greek_iotaaccent, Greek iotadieresis, Greek iotaaccentdieresis, Greek_omicronaccent,
Greek_upsilonaccent, Greek_upsilondieresis, Greek_upsilonaccentdieresis,
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Greek_omegaaccent, Greek ALPHA, Greek BETA, Greek GAMMA, Greek_ DELTA,
Greek_EPSILON,  Greek ZETA, Greek ETA, Greek THETA, Greek IOTA,
Greek KAPPA,  Greek LAMDA,  Greek LAMBDA,  Greek MU,  Greek NU,
Greek_XI, Greek OMICRON, Greek_PI, Greek RHO, Greek SIGMA, Greek TAU,
Greek_UPSILON, Greek PHI, Greek CHI, Greek PSI, Greek OMEGA, Greek_alpha,
Greek_beta, Greek_gamma, Greek delta, Greek_epsilon, Greek zeta, Greek eta,
Greek_theta, Greek_iota, Greek_kappa, Greek_lamda, Greek_ lambda, Greek_mu,
Greek_nu,  Greek xi,  Greek_omicron,  Greek pi,  Greek rho,  Greek sigma,
Greek_finalsmallsigma, Greek_tau, Greek upsilon, Greek phi, Greek chi, Greek_psi,
Greek_omega, Greek_switch,

hebrew_doublelowline, hebrew_aleph, hebrew_bet, hebrew_beth, hebrew_gimel, he-
brew_gimmel, hebrew_dalet, hebrew_daleth, hebrew_he, hebrew_waw, hebrew_zain,
hebrew_zayin, hebrew_chet, hebrew_het, hebrew_tet, hebrew_teth, hebrew_yod, he-
brew_finalkaph, hebrew_kaph, hebrew_lamed, hebrew_finalmem, hebrew_mem, he-
brew_finalnun, hebrew_nun, hebrew_samech, hebrew_samekh, hebrew_ayin, he-
brew_finalpe, hebrew_pe, hebrew_finalzade, hebrew_finalzadi, hebrew_zade, hebrew_zadi,
hebrew_qoph, hebrew_kuf, hebrew_resh, hebrew_shin, hebrew_taw, hebrew_taf, He-
brew_switch,

Thai_kokai, Thai_khokhai, Thai_khokhuat, Thai_khokhwai, Thai_khokhon,
Thai_khorakhang, Thai_ngongu, Thai_chochan, Thai_choching, Thai_chochang,
Thai_soso, Thai_chochoe, Thai_yoying, Thai_dochada, Thai_topatak, Thai_thothan,
Thai_thonangmontho, Thai_thophuthao, Thai_nonen, Thai_dodek, Thai_totao,
Thai_thothung,  Thai_thothahan, Thai thothong, Thainonu, Thai_bobaimai,
Thai_popla, Thai_phophung, Thai_fofa, Thai_phophan, Thai fofan, Thai_phosamphao,
Thai_moma, Thai_yoyak, Thai_rorua, Thai_ru, Thai_loling, Thai_lu,
Thai_wowaen, Thai_sosala, Thai_sorusi, Thai_sosua, Thai_hohip, Thai_lochula,
Thai_oang,  Thai_honokhuk,  Thai_paiyannoi, = Thai_saraa, = Thai_maihanakat,
Thai_saraaa, Thai_saraam, Thai_sarai, Thai_saraii, Thai_saraue, Thai_sarauee,
Thai_sarau, Thai_sarauu, Thai_phinthu, Thai_maihanakat_maitho, Thai_baht,
Thai_sarae, Thai_saraae, Thai_sarao, Thai_saraaimaimuan, Thai_saraaimaimalai,
Thai_lakkhangyao, Thai_maiyamok, Thai_maitaikhu, Thai_maiek, Thai_maitho,
Thai_maitri, Thai_maichattawa, Thai_thanthakhat, Thai_nikhahit, Thai_leksun,
Thai_leknung, Thai leksong, Thai leksam, Thai leksi, Thai lekha, Thai_lekhok,
Thai_lekchet, Thai_lekpaet, Thai_lekkao,

Hangul, Hangul Start, Hangul End, Hangul Hanja, Hangul Jamo, Hangul Romaja,
Hangul_Codeinput, Hangul _Jeonja, Hangul Banja, Hangul_PreHanja,
Hangul PostHanja, Hangul SingleCandidate, Hangul MultipleCandidate,
Hangul PreviousCandidate, Hangul Special, Hangul switch, Hangul Kiyeog,
Hangul SsangKiyeog, Hangul KiyeogSios, Hangul Nieun, Hangul NieunlJieuj,
Hangul_NieunHieuh, Hangul_Dikeud, Hangul _SsangDikeud, Hangul_Rieul,
Hangul_RieulKiyeog, Hangul RieulMieum, Hangul RieulPieub, Hangul RieulSios,
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Hangul RieulTieut, = Hangul RieulPhieuf, = Hangul RieulHieuh, = Hangul Mieum,
Hangul Pieub, Hangul_SsangPieub, Hangul_PieubSios, Hangul_Sios, Hangul SsangSios,
Hangul Teung, Hangul Jieuj, Hangul SsanglJieuj, Hangul Cieuc, Hangul Khieuq,
Hangul_Tieut, Hangul_Phieuf, Hangul_Hieuh, Hangul A, Hangul AE,
Hangul YA, Hangul YAE, Hangul EO, Hangul E, Hangul YEO, Hangul YE,
Hangul O, Hangul WA, Hangul WAE, Hangul OE, Hangul. YO, Hangul U,
Hangul WEO, Hangul WE, Hangul WI, Hangul YU, Hangul EU, Hangul YI,
Hangul_I, Hangul_J_Kiyeog, Hangul_J_SsangKiyeog, Hangul_J_KiyeogSios,
Hangul J_Nieun, Hangul J_NieunJieuj, Hangul J_NieunHieuh, Hangul J_Dikeud,
Hangul J_Rieul, Hangul _J_RieulKiyeog, Hangul J_RieulMieum, Hangul J_RieulPieub,
Hangul_J_RieulSios, Hangul_J_RieulTieut, Hangul_J_RieulPhieuf, Hangul_J_RieulHieuh,

Hangul J_Mieum, Hangul _J_Pieub, Hangul _J_PieubSios, Hangul J_Sios,
Hangul_J_SsangSios, Hangul J_Ieung, Hangul J_Jieuj, Hangul_J_Cieuc,
Hangul_J_Khieuq, Hangul_J_Tieut, Hangul_J_Phieuf, Hangul_J_Hieuh,
Hangul RieulYeorinHieuh, Hangul_SunkyeongeumMieum, Hangul SunkyeongeumPieub,
Hangul PanSios, Hangul KkogjiDalrinleung, Hangul SunkyeongeumPhieuf,
Hangul_YeorinHieuh, Hangul AraeA, Hangul AraeAE, Hangul J_PanSios,

Hangul J_KkogjiDalrinleung, Hangul_J_YeorinHieuh, Korean_Won,

Armenian_eternity, Armenian_section_sign, Armenian_full stop, Armenian_verjaket,
Armenian_parenright, Armenian_parenleft, Armenian_guillemotright, Arme-
nian_guillemotleft, Armenian_em_dash, Armenian_dot, Armenian_mijaket, Arme-
nian_separation_mark, Armenian_but, Armenian comma, Armenian_en dash, Ar-
menian_hyphen, Armenian_yentamna, Armenian_ellipsis, Armenian_exclam, Ar-
menian_amanak, Armenian_accent, Armenian_shesht, Armenian_question, Arme-
nian_paruyk, Armenian_AYB, Armenian_ayb, Armenian_ BEN, Armenian_ben, Ar-
menian_GIM, Armenian_gim, Armenian_ DA, Armenian_da, Armenian_ YECH, Ar-
menian_yech, Armenian_ZA, Armenian_za, Armenian_E, Armenian_e, Armenian_AT,
Armenian_at, Armenian_TO, Armenian_to, Armenian ZHE, Armenian zhe, Arme-
nian_INI; Armenian_ini, Armenian_ LYUN, Armenian_lyun, Armenian KHE, Arme-
nian_khe, Armenian_TSA, Armenian_tsa, Armenian KEN, Armenian_ken, Arme-
nian_HO, Armenian_ho, Armenian_DZA, Armenian_dza, Armenian GHAT, Arme-
nian_ghat, Armenian_TCHE, Armenian_tche, Armenian_MEN, Armenian_men, Arme-
nian_HI, Armenian_hi, Armenian_NU, Armenian_nu, Armenian_SHA, Armenian_sha,
Armenian_VO, Armenian_vo, Armenian CHA, Armenian_cha, Armenian PE, Arme-
nian_pe, Armenian_JE, Armenian_je, Armenian_RA, Armenian_ra, Armenian _SE,
Armenian_se, Armenian_ VEV, Armenian_vev, Armenian_ TYUN, Armenian_tyun,
Armenian_RE, Armenian_re, Armenian_TSO, Armenian_tso, Armenian_VYUN, Ar-
menian_vyun, Armenian PYUR, Armenian_pyur, Armenian KE, Armenian ke, Ar-
menian_O, Armenian_o, Armenian FE, Armenian_fe, Armenian_apostrophe, Arme-
nian_ligature_ew,

Georgian_an, Georgian_ban, Georgian_gan, Georgian_don, Georgian_en, Georgian_vin,
Georgian_zen, Georgian_tan, Georgian_in, Georgian_kan, Georgian_las, Georgian_man,
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Georgian_nar, Georgian_on, Georgian_par, Georgian_zhar, Georgian_rae, Georgian_san
? 7 Y 9 9 ?
Georgian_tar, Georgian_un, Georgian_phar, Georgian khar, Georgian_ghan, Geor-
gian_qar, Georgian_shin, Georgian_chin, Georgian_can, Georgian_jil, Georgian_cil, Geor-
gian_char, Georgian_xan, Georgian_jhan, Georgian_hae, Georgian_he, Georgian_hie,
Georgian_we, Georgian_har, Georgian_hoe, Georgian_fi
) ) ) )

2.5. File Sets

Wing provides a way to define sets of files that can be used in various ways within the
IDE, such as for searching particular batches of files and adding only certain kinds of
files to a project.

To view or alter the defined file sets, use the File Sets... item in the File menu. This
will display a file set editor within the Preferences manager.

When adding or editing a file set, the following information may be entered:

e Name -- The name of the file set

e Includes - A list of inclusion criteria, each of which contains a type and a spec-
ification. A file will be included in the file set if any one of these include criteria
matches it.

e Excludes -- A list of exclusion criteria, any of which can match to cause a file to
be excluded from the file set even if one or more include matches were also found.

The following types of include and exclude criteria are supported:

e Wildcard on Filename -- The specification in this case is a wildcard that must
match the file name. The wildcards supported are those provided by Python’s
fnmatch module.

e Wildcard on Directory Name -- The specification in this case is a wildcard
that must match the directory name.

e Mime Type -- The specification in this case names a MIME type supported by
Wing IDE. If additional file extensions need to be mapped to a MIME type, use
the Extra File Types preference to define them.

Once defined, file sets are presented by name in the Search in Files tool’s batch search
facility and in the Project tool’s batch file addition features.

Any problems encountered in using the file sets are reported in the Messages area.


http://wingware.com/psupport/python-manual/2.3/lib/module-fnmatch.html

20



Project Manager

The project manager provides a convenient index of the files in your software project and
collects information needed by Wing’s debugger, source code analysis tools, and other
facilities.

To get the most out of Wing’s debugger and source analysis engine, you must add your
source base to your project file and may in some cases need to set up PYTHONPATH and
other values in Project-Wide Properties and/or Per-File Properties.

3.1. Creating a Project

To create a new project, use the New Project item in the Project menu. This will
prompt you to save any changes to your currently open project and will create a new
blank project. If Wing is started without any command line arguments, the most recent
project is opened, or if no project exists then the Default Project is opened.

To add files to your project, use the following items in the Project menu:

e Add Current File will add the frontmost current open file to the project if it is
not already there.

e Add New File is used to create a new file and simultaneously add it to your
project.

e Add File will prompt you to select a single file to add to the project view. Note
that this also may result in adding a new directory to the project manager window,
if that file is the first to be added for a directory.

e Add Package can be used to add more than one file at once. Select a directory
with your left mouse button so that the directory name is shown in the area at the
bottom of the file selection window. Then click OK. You will be prompted with a
list of files within the selected directory. Highlight any that you wish to add, using
shift-click to highlight a contiguous range or ctrl-click to select an arbitrary set.
Then click Yes to add all those files to your project.

o1
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e Add Directory Tree can be used to add many files in a directory structure in one
operation. Select a directory from the provided list. Once this dialog is accepted,
Wing will add files recursively from the selected directory and all its children.

A subset of these options be accessed from the popup menu that appears when right-
clicking your mouse on the surface of the project manager window.

3.2. Removing Files and Packages

To remove a specific file, select it and use the Remove From Project menu item in the
right-click popup menu from the surface of the Project Manager window, or by selecting
an item on the project and using Remove Selected Entry in the Project menu. You can
also remove a whole directory and all the files that it contains in this way.

3.3. Saving the Project

Once a project file has been saved the first time, it will be auto-saved whenever you
close the project, start a debug session, or exit Wing. This behavior can be turned off
with the Save without Asking preference.

You can also save a copy of your project to another location or name with Save Project
As. .. in the Project menu.

Moving Project Files

Using Save Project As... is recommended if you need to alter the location of
your project file in relation to your source files because it will update the partial
relative paths that the project manager uses to locate files in the project. Otherwise,
Wing may not be able to find all of the files in the project.

3.4. Sorting the View

The project can be set to show your files in one of several modes, using the Options
menu in the top right of the project view:

e By Flattened Tree -- This view (the default) shows files organized according to
their location on disk. Each directory is shown at the top level with path names
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shown as partial relative paths based on the location of the project file. If you
alter the location of the project file with Save Project As..., these paths will
be updated accordingly.

e By Tree -- This displays the project files in true tree form. The tree structure is
based on the partial relative path from the project file.

e By Mime Type -- This view organizes your files by MIME type.

3.5. Keyboard Navigation
Once it has the focus, the project manager tree view is navigable with the keyboard,
using the up/down arrow keys, page up and page down, and home/end.

Use the right arrow key on a parent to display its children, or the left arrow key to hide
them.

Holding down the shift key while pressing the right arrow will expand recursively below
the expansion point. Recursive expansion is capped at five additional levels for each
operation to avoid infinite recursion resulting from symbolic links.

Whenever a tree row is selected, pressing enter or return will open that item within
Wing IDE.

3.6. Sharing Projects

Project File Types

There are two related formats in which you can save your project. One supports
sharing the project file with other developers, via a revision control system or other
method.

The default project type is 'Normal’, which stores all project data into a single file. The
file name for these files should end in ’ .wpr’.

To share a project file with other developers, change Project Type in the Options tab
of Project Properties to Shared (Two Files). Then save your project to obtain the
two separate project files on disk. The main project file name ends in ’.wpr’ and will
contain only shareable data. All user-specific data will be stored in a separate file with
name ending in ’.wpu’.



o4

If you subsequently change from a Shared project back to Normal, the user-specific data
will be merged back into the machine project file and the file ending in ’ .wpu’ will be
removed from disk.

Note that both the combined 'Normal’ file and two split 'Shared’ files use the same
textual file format that is used for the preferences file. See section Preferences File
Format for more information on the format itself.

3.7. Project-wide Properties

Each project has a set of top-level properties that can be accessed and edited via the
Properties item in the Project menu. These can be used to configure the Python
environment used by the debugger and the source code analysis engine, which drives
Wing’s auto completion, source index, and other capabilities. Project properties are also
provided to set options for the project and to enable and configure extensions for revision
control, Zope, and other tools.

Any string value for a property may contain environment variable references using the
$ (name) notation. Anything inside the parentheses will be interpreted as the name of
an environment variable and will be replaced with the value of the environment variable
when it used by the IDE. If the environment variable is not set, the reference will be
replaced by an empty string. The system environment, as modified by the project-wide
environment property (see below), is used to expand variable references.

Environment

To get the most out of Wing, it is important to set these values in the Environment tab
correctly for your project:

Python Executable -- When the Custom radio button is checked and the entered field
is non-blank, this can be used to set the full path to the Python executable that should
be used when debugging source code in this project. When Use default is selected, Wing
tries to use the default Python obtained by typing python on the command line. If this
fails, Wing will search for Python in /usr/local and /usr (on Linux/Unix) or in the
registry (on Windows).

Python Path -- The PYTHONPATH is used by Python to locate modules that are imported
at runtime with the import statement. When the Use default checkbox in this area
is checked, the inherited PYTHONPATH environment variable is used for debug sessions.
Otherwise, when Custom setting is selected, the specified PYTHONPATH is used.

Environment -- This is used to specify values that should be added, modified, or
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removed from the environment that is inherited by debug processes started from Wing
IDE and is used to expand enviroment variable references used in other properties.
Each entry is in var=value form and must be specified one per line in the provided
entry area. An entry in the form var= (without a value) will remove the given variable
to be undefined. Note that you are operating on the environment inherited by the
IDE when it started and not modifying an empty environment. When the Use system
environment choice is set, any entered values are ignored and the inherited environment
is used without changes.

Debug

The following properties are defined in the Debug tab:

Initial Directory -- When the Use default radio button is checked, the initial working
directory set for each debug session will be the location where the main entry point
file or project file is located. Otherwise, when Custom setting is selected, the specified
directory is used or, when blank, the project file’s directory is used.

Build Command -- This command will be executed before starting debug on any
source in this project. This is useful to make sure that C/C++ extension modules are
built, for example in conjunction with an external Makefile or distutils script, before
execution is started.

Options

These project options are provided:

Project Type -- This can be used to select whether or not the project will be shared
among several developers. When shared, the project will be written to two files, one of
which can be shared with other developers. See Project Types for details.

Preferred Line Ending and Line Ending Policy control whether or not the project
prefers a particular line ending style (line feed, carriage return, or carriage return + line
feed), and how to enforce that style, if at all. By default, projects do not enforce a line
ending style but rather insert new lines to match any existing line endings in the file.

Preferred Indent Style and Indent Style Policy control whether or not the project
prefers a particular type of indentation style for files (spaces only, tabs only, or mixed
tabs and spaces), and how to enforce that style, if at all. By default, projects do not
enforce an indent style but rather insert new lines to match any existing indentation in
the file.
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The Extensions tab of Project Properties is used to control revision control and other
add-ons on a per-project basis:

Enable Revision Control and Revision Control System are used to turn on a
particular revision control integration for this project. Currently, only a minimalist
CVS integration is available.

Enable Zope2/Plone Support and Zope2 Instance Home are used for Zope 2.x
and Plone projects to provide the Instance Home directory used by Zope. This is needed
because Zope 2.x implements import magic that works differently from Python’s default
import and thus adding the instance home directory to PYTHONPATH is not sufficient.
Wing’s source analyzer needs this extra clue to properly find and process the Zope
instance-specific sources.

If you are sharing a project file with other developers through a revision control system,
and have set Project Type Shared, it is important to note that the above values are
stored in the private branch of the project file. This means that each developer needs to
set these values independently, to match the specific environment on their development
machine.

3.8. Per-file Properties

Per-file properties can be set by right-clicking on a source file and selecting the Prop-
erties menu item in the popup, by right-clicking on a file in the project view and
selecting File Properties, or by opening a file and using the Current File Proper-
ties... item in the Source menu. For Debug and Python Settings, values entered here
will override any corresponding project-wide values.

File Attributes

File Type -- This property specifies the file type for a given file, overriding the type
determined automatically from its file extension and/or content. This property is recom-
mended only when the Extra File Types preference cannot be used to specify encoding
based on filename extension.

Encoding -- This can be used to specify the encoding with which a file will be saved.
When it is altered, the file will be opened into an editor and the encoding will not
change until it is saved to disk. If it is not saved, the encoding attribute will revert to
its previous setting. The encoding cannot be altered with this property if it is being
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defined by an encoding comment in a Python, HTML, XML, or gettext PO file. In this
case, the file should be opened and the encoding comment changed. Wing will save the
file under the newly specified encoding.

Important: Files saved under a different encoding without an encoding comment may
not be readable by other editors because there is no way for them to determine the file’s
encoding if it differs from the system or disk default. Wing stores the selected encoding
in the project file, but no mark is written in the file except for those encodings that
naturally use a Byte Order Mark (BOM), such as utf_8, utf_16_le, utf_16_be, utf_32_le.
utf_32_be.

Line Ending Style -- Specifies which type of line ending (line feed, carriage return, or
carriage return and line feed) is used in the file. When altered, the file will be opened
and changed in an editor. The change does not take effect until the file is saved to disk.

Indent Style -- This property can be used in non-Python files to change the type of
indent entered into the file for newly added lines. For Python files, the only way to alter
indentation in a file is with the Indentation manager.

Read-only on Disk -- This property reflects whether or not the file is marked read-only
on disk. Altering it will change the file’s disk protections for the owner of the file (on
Posix, group/world permissions are never altered).

Editor

These properties define how the file is displayed in the editor:

Show Whitespace -- This allows overriding the Show White Space preference on a
per-file basis.

Show EOL -- This allows overriding the Show EOL preference on a per-file basis.

Show Indent Guides -- This allows overriding the Show Indent Guides preference
on a per-file basis.

Ignore Indent Errors -- Wing normally reports potentially serious indentation incon-
sistency in Python files. This property can be used to disable this check on a per-file
basis (it is also available in the warning dialog).

Ignore EOL Errors -- When the project’s Line Ending Policy is set to warn about
line ending mismatches, this property can be used to disable warnings for a particular

file.
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Environment

These properties are the same as for the Python Settings defined in Project-Wide
Properties. Values defined per-file override the corresponding project-wide property.

For the Environment attribute, note that the option menu area contains some addi-
tional choices. Use add to project values to apply the values specified here to the run-
time environment specified by the project, or add to system environment to bypass the
project-wide values and apply the per-file values directly to the environment set by the
operating system.

Debug

The per-file debug properties dialog contains all the same fields described in Project-
Wide Properties, with the following additions:

Run Arguments -- Enter any run arguments here. Wing does not interpret backslashes
(") on the command line and passes them unchanged to the debug process. The only
exceptions to this rule are \’ and \" (backslash followed by single or double quote),
which allow inclusion of quotes inside quoted multi-word arguments.

Show this dialog before each run -- Check this checkbox if you want the debug
options dialog to appear each time you start a debug session.

Values defined per-file override or modify the corresponding project-wide property.

When debugging, only per-file debug properties set on the initially invoked file are used.
Even if other files with set properties are used in the debug session, any values set for
them will be ignored.

3.9. Navigating to Files

Files can be opened from the project manager window by double clicking or middle
clicking on the file name, or right-clicking and using the Open in Wing IDE menu item.

Files may also be opened using an external viewer or editor by right-clicking on the file
and using the Open in External Viewer item. On Windows and Mac OS X, this opens
the file as if you had double clicked on it. On Linux, the preferences File Display
Commands and Extra Mime Types can be used to configure how files are opened.

You can also execute Makefiles, python source, and any executable files by selecting the
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Execute Selected File item from the popup menu. This executes outside of the debugger
with any input/output occurring in the window from which Wing was launched (if any).
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Source Code Editor

Wing IDE’s source code editor is designed to make it easier to adopt the IDE even if
you are used to other editors.

Editor Overview
Key things to know about the editor are:

e The editor has personalities that emulate other commonly used editors such
as Visual Studio, VI/Vim, Emacs, and Brief.

e Context-appropriate auto-completion, goto-definition, and code index menus
are available when working in Python code

e The editor supports a wide variety of file types for syntax colorization.
e Key mappings and many other behaviors are configurable.

e The editor supports structural folding for some file types

4.1. Syntax Colorization

The editor will attempt to colorize documents according to their MIME type, which is
determined by the file extension, or content. For example, any file ending in .py will
be colorized as a Python source code document. Any file whose MIME type cannot be
determined will display all text in black normal font by default.

All the available colorization document types are listed in the File Properties dialog’s
Editor tab. If you have a file that is not being recognized automatically, you can use the
File Type menu found there to alter the way the file is being displayed. Your selections
from this menu are stored in your project file, so changes made are permanent in the
context of that project.

61
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If you have many files with an unrecognized extension, use the Extra File Types
preference to add your extension.

4.2. Right-click Editor Menu

Editor Popup Menu

Right-clicking on the surface of the editor will display a context menu with commonly
used commands such as Copy, Paste, Goto Definition, and indentation operations.
User-defined scripts may also add items here, as described in the Scripting chapter.

4.3. Navigating Source

The set of menus at the top of the editor can be used to navigate through your source
code. When editor tabs are hidden, the left-most of these menus lists the currently open
files by name. The additional popup menus indicate the scope of the current cursor
selection in the file and may be used to navigate within the top-level scope, or within
sub-scopes when they exist.

You can also use the Goto Definition menu item in the editor context menu to click
on a construct in your source and zoom to its point of definition. Alternatively, place
the cursor or selection on a symbol and use the Goto Selected Symbol Defn item in the
Source menu, or its keyboard equivalent.

4.4. File status and read-only files

The editor tabs, or editor selection menu when the tabs are hidden, indicate the status of
the file by appending * when the file has been edited or (r/o0) when the file is read-only.
This information is mirrored for the current file in the status area at the bottom left of
each editor window.

Files that are read-only on disk are initially opened within a read-only editor. Use the
file’s context menu (right-click) to toggle between read-only and writable state. This
alters both the editability of the editor and the writability of the disk file.
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4.5. Transient vs. non-Transient Editors

Wing can open files in two modes:

Transient Mode -- Files opened when searching, debugging, navigating to point of
definition, and using the Project and Source Browser tools with the Follow Selection
checkbox enabled are all opened in transient mode and will be automatically closed when
hidden. The maximum number of non-visible transient files to keep open at any given
time can be set with the Editor / Advanced / Transient Threshold preference.

Non-Transient Mode -- Files opened normally from the File menu, from the keyboard
file selector, or by double clicking on items in the Project tool will be opened in non-
transient mode, and kept open until they are explicitly closed. Transient files that are
edited are also automatically converted to non-transient mode.

A file can be switched between transient and non-transient mode by clicking on the
stick pin icon in the upper right of the editor area. Right-click on the stick pin icon to
navigate to recently visited files (blue items were transient, black items non-transient).

4.6. Structural Folding

The editor supports optional structural folding for Python, C, C++, Java, Javascript,
HTML, Eiffel, Lisp, Ruby, and a number of other file formats. This allows you to visually
collapse logical hierarchical sections of your code while you are working in other parts
of the file.

You can turn Structural Folding on and off as a whole with the Enable Folding pref-
erence.

The Fold Line Mode preference can be used to determine whether or not a horizontal
line is drawn at fold points, whether it is drawn above or below the fold point, and
whether it is shown when the fold point is collapsed or expanded. Fold Indicator
Style is used to select the look of the fold marks shown at fold points.

Once folding is turned on, an additional margin appears to the left of source files, where
fold points are displayed. Left mouse click on one of these marks to collapse or expand
that fold point. Right mouse clicking anywhere on the fold margin displays a context
menu with the various folding operations.

You can also hold down the following key modifiers while left-clicking to modify the
folding behavior:

e Shift -- Clicking on any fold point while holding down the shift key will expand
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that point and all its children recursively so that the maximum level of expansion
is increased by one.

Ctrl -- Clicking on any fold point while holding down the ctrl key will collapse
that point and all its children recursively so that the maximum level of expansion
is decreased by one.

Ctrl4-Shift -- On a currently expanded fold point, this will collapse all child fold
points recursively to maximum depth, as well as just the outer one. When the
fold point is subsequently re-expanded with a regular click, its children will appear
collapsed. Ctrl-shift-click on a collapsed fold point will force re-expansion of all
children recursively to maximum depth.

Fold commands are also available in the Structural Folding section of the Source
menu, indicates the key equivalents assigned to the operations:

Toggle Current Fold -- Like clicking on the fold margin, this operates on the
first fold point found in the current selection or on current line.

Collapse Current More -- Like ctrl-clicking, this collapses the current fold point
one more level than it is now.

Expand Current More -- Like shift-clicking, this expands the current fold point
one more level than it is now.

Collapse Current Completely -- Like shift-ctrl-clicking on an expanded node,
this collapses all children recursively to maximum depth.

Expand Current Completely -- Like shift-ctrl-clicking on a collapsed node, this
ensures that all children are expanded recursively to maximum depth.

Collapse All -- Unconditionally collapse the entire file recursively.
Expand All -- Unconditionally expand the entire file recursively.

Fold Python Methods -- Fold up all methods in all classes in the file.
Fold Python Classes -- Fold up all classes in the file.

Fold Python Classes and Defs -- Fold up all classes and any top-level function
definitions in the file.



4.7. Brace Matching

Wing will highlight matching braces in green when the cursor is adjacent to a brace.

Mismatched braces are highlighted in red.

You can cause Wing to select the entire contents of the innermost brace pair from the

current cursor position with the Match Braces item in the Source menu.

Parenthesis, square brackets, and curly braces are matched in all files. Angle brackets

(< and >) are matched also in HTML and XML files.

4.8. Indentation

Since indentation is syntactically significant in Python, Wing provides a range of features

for inspecting and managing indentation in source code.

Indentation Preferences

The following preferences affect how the indentation features behave:

1)

The Use Indent Analysis preference is used to control whether analysis
of current file content is used to determine the type of indentation placed
during edits. It can be enabled for all files, only for Python files, or disabled.

The Default Tab Size preference defines the position of tab stops and is
used to determine the rendering of files with tabs only, or non-Python files
with mixed tab and space indentation. In Python files with mixed indents,
this value is ignored and the file is always shown in the way that the Python
interpreter would see it.

The Default Indent Size preference defines the default size of each level
of indent, in spaces. This is used in new empty files or when indent analysis
has been disabled. Wing may override this value in files that contain only
tabs in indentation, in order to make it a multiple of the configured tab size.

The Default Indent Style preference defines the default indentation style,
one of spaces-only, tabs-only, or mixed. This is used in new empty files
or when indent analysis has been disabled. Mixed indentation replaces each
tab-size spaces with one tab character.

These preferences define how indentation is handled by the editor:



66

5) The Auto-Indent preference controls whether or not each new line is auto-
matically indented.

6) The Show Indent Guides preference controls whether or not to show in-
dentation guides as light vertical lines. This value can be overridden on a
file-by-file basis from Editor tab in File Properties.

7) The Show Python Indent Warnings preference can be used to enable
or disable warnings for Python files that may contain confusing or damaged
indentation.

8) The Show Override Warnings preference controls whether or not Wing
shows a warnings when the user enters indentation that does not match the
form already within a file. This is currently only possible in non-Python files,
by altering the Indent Style attribute in File Properties.

How Indent Style is Determined

When an existing file is opened, it is scanned to determine what type of indentation is
used in that file. If the file contains some indentation, this may override the tab size,
indent size, and indent style values given in preferences and the file will be indented in
a way that matches its existing content rather than with your configured defaults. If
mixed forms of indentation are found, the most common form is used.

For Python files, the detected form of indentation cannot be overridden and Wing will
always match new indentation to existing indentation. Mixing indentation styles in
Python is dangerous because indentation has syntactic importance.

For non-Python files, you can change indentation style on the fly using the Indent Style
property in the File Properties dialog. This allows creating files that intentionally
mix indentation forms in different parts of the file. To ask Wing to return to the form of
indentation it determines as most prominent in the file, select Match Existing Indents.

You may also convert the entire file between different forms of indentation using the
Indentation Manager available from the Indentation portion of the Source menu. This
is described in Indentation Manager.

Tab Size

Tab size is automatically forced to 8 characters for all Python source files that
contain some spaces in indentation. This is done because the Python interpreter
defines tabs as 8 characters in size when used together with spaces. This version
of Wing does not recognize vi style tab size comments, but it does apply the Tab
Size preference when a file contains only tabs in indentation, or if it is a non-Python
file.
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Indentation Policy

The project manager also provides the ability to define the preferred indentation style
(overriding the preference-defined style) and to specify a policy for enforcing line endings,
on a per-project basis. This is accomplished with Preferred Line Ending and Line
Ending Policy under Options in Project Properties.

4.8.1. Auto-Indent

The IDE ships with auto-indent turned on. This causes leading white space to be added
to each newly created line, as return or enter are pressed. Enough white space is inserted
to match the indentation level of the previous line, possibly adding or removing a level of
indentation if this is indicated by context in the source (such as if, while, or return).

Note that if preference Auto-indent is set to false, auto-indent does not occur until
the tab key is pressed.

4.8.2. The Tab Key

By default, the tab key either indents according to context or increases the indent depth
at the current cursor position by one level (this depends on the selected editor Person-
ality). If one or more lines are selected, this instead operates on the indentation of all
selected lines by one level.

To insert a real tab character regardless of the indentation mode or the position of the
cursor on a line, type Ctrl-Tab or Ctrl-T.

The behavior of the tab key can be altered using the Tab Key Action preference.

4.8.3. Checking Indentation

Wing IDE analyses existing indentation whenever it opens a Python source file, and will
indicate a potentially problematic mix of indentation styles, allowing you to attempt to
repair the file. Files can be inspected more closely or repaired at any time using the
Indentation Manager.

To turn off indentation warnings in Python files, use the Show Python Indent Warn-
ings preference.

Wing also indicates suspiciously mismatched indentation in source code by underlining
the indent area of the relevant lines in blue.
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In general, mixing tab/space and space-only indentation in the same file can be
confusing, especially if files are viewed with different editors and by different de-
velopers. We recommend using spaces only or tabs only as the best alternatives.
To convert existing code containing a mix of tabs and spaces, use the Indentation
Manager.

4.8.4. Changing Block Indentation

Wing provides Indent and Outdent commands in the Indentation portion of the Source
menu, to support increasing or decreasing the level of indentation for selected blocks of
text. All lines that are included in the current text selection are moved, even if the entire
line isn’t selected.

Indentation placed by these commands will contain either only spaces, only tabs, or a
mixture of tabs and spaces, as determined by the method described in Indentation.

Indenting to Match

The command Indent Lines to Match (also in the Indentation sub-menu) will
indent or outdent the current line or selected lines to the level as a unit so that the
first line is positioned as it would have been positioned by Wing's auto-indentation
facility. This is very useful when moving around blocks of code.

4.8.5. Indentation Manager

The Indentation manager, accessible from the Tools menu, can be used to inspect and
change indentation style in source files. It has two parts: (1) The indentation report,
and (2) the indentation converter.

A report on the nature of existing indentation found in your source file is given above
the horizontal divider. This includes the number of spaces-only, tabs-only, and mixed
tabs-and-space indents found, information about whether indentation in the file may be
problematic to the Python interpreter, and the tab and indent size computed for that
file. The manager also provides information about where the computed tab and indent
size value come from (for example, an empty file results in use of the defaults configured
in preferences).

Conversion options for your file are given below the horizontal divider. The three tabs
are used to select the type of conversion desired, and each tab contains information about
the availability and action of that conversion, and a button to start the conversion. Most
of these conversions have no parameters that can be altered by the user. Only in the
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case of conversion from tabs-only to spaces-only indentation styles, the tab size value
shown in the indentation report is made editable, so that the configured default can be
overridden.

Once conversion is complete, the indentation manager updates to display the new status
of the file, and action of any subsequent conversions.

4.9. Auto-completion

While typing in Python source code, Wing will display a context-appropriate auto-
completion list. To use it, type until the correct symbol is hilighted in the list and
then press the tab key. Wing will fill in the remaining characters for the source symbol,
correcting any spelling errors you might have made in the name.

If you wish to select a name without typing enough of the name to make your selection
unique in the auto-completer, you can use the keyboard up and down arrow keys or
mouse to scroll up and down in the popup list. Pressing tab or double clicking on a list
item will complete that symbol in your source.

To cancel out of the auto-completion popup, press the Esc key or ctrl-g. The auto-
completer will also disappear when you exit the source symbol (for example, by pushing
space or any other character that can’t be contained in a source symbol), if you click
elsewhere on the surface of the source code, or if you issue other keyboard bound com-
mands that are not accepted by the auto-completer (for example, save through keyboard
equivalent or right/left arrow keys).

Auto-completion Limitations
Auto-completion covers most but not all possible scenarios at this time. See section
Source Code Analysis for more information on current capabilities.

4.10. Source Assistant

Wing’s Source Assistant tool can be used while viewing or editing source code to
display additional information about the point of definition of source constructs located
near the current insertion cursor position.

The following data is displayed in the source assistant:

e File -- The file and line number where the source symbol is defined
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e Call Signature -- The function or method name, arguments, and return value if
known for the source construct. The class name is also included if available. This
value is blank for non-callable values.

e Doc String -- The documentation string for the source symbol, if available
Consider the following example where the | at the end of myfile2 represents the inser-
tion cursor:
myfilel.py:

class A:
"""This is an example class"""

def meth(self, x):
"""This is an example method that takes one parame-
ter other than self
and returns a dictionary"""

return {}

myfile2.py:

import myfilel
a = myfilel.AQ)
a.meth]|

In this case, after the user has typed a.meth, Wing will look up the docstring and call
signature for the meth method on class A and will display information about it in the
source assistant:

File: myfilel.py, line 4
Call Signature: A.meth(self, x) -> dict
Doc String: This is an example method that takes one pa-

rameter other
than self and returns a dictionary

Note that Wing cannot determine the types of all arguments or return values, but
presents as much information as it can glean from the source code. To help Wing
produce a more complete analysis of your source code, you can add statements such as
the following to provide hints of the types of values:
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assert isinstance(myvalue, mymodule.CMyClass)

For extension modules written in C/C++, Wing will try to load and inspect the module
to determine its contents. However, due to the design of Python’s extension module
capability, the resulting information is more limited than what can be obtained from a
Python file. To augment this, Wing can be given an interface file, which is a Python
skeleton that replicates the functions, attributes, classes, and methods defined by the ex-
tension module. These files should be given the name of the extension module plus *.pi.
For example, for an extension module imported as mymodule, the interface file would be
named mymodule.pi. Examples of interface files can be see in resources/builtin-pi-
files inside your Wing IDE installation.

4.11. Auto-save

The source code editor auto-saves files to disk every few seconds. The auto-save files are
placed in a subdirectory of your User Settings Directory.

If Wing ever crashes or is killed from the outside, you can use these files to recover any
unsaved changes. Copy the auto-save files to overwrite the older unsaved files, doing a
comparison first to verify that the auto-save file is what you want.

4.12. Notes on Copy/Paste

There are a number of ways to copy and paste text in the editor:
e Use the Edit menu items. This stores the copy/cut text in the system-wide clip-
board and can be pasted into or copied from other applications.
e Use key equivalents as defined in the Edit menu.
e Right-click on the editor surface and use the items in the popup menu that appears.

e Select a range of text and drag it using the drag and drop feature (pressing shift
before dropping will move text rather than copy it)

e On Linux, select text anywhere on the display and then click with the middle
mouse button to insert it at the point of click.

e In emacs mode, ctrl-k (kill-line) will cut one line at a time into the private
emacs clipboard. This is kept separate from the system-wide clipboard and is
pasted using ctrl-y (yank-line). On Windows and Mac OS X, ctrl-y will paste
the contents of the system-wide clipboard only if the emacs clipboard is empty.
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e In VI mode, named text registers are supported.

e On Windows and Mac OS X, click with the middle mouse button to insert the
current emacs private clipboard (if in emacs mode and the buffer is non-empty)
or the contents of the system-wide clipboard (in all other cases). On Mac OS X,
the middle mouse button is emulated by holding down the command key while
clicking.

It’s important to note which actions use the system-wide clipboard, which use the emacs
private clipboard or VI registers, and which use the X windows selection (X Windows
only). Otherwise, these commands are interchangeable in their effects.

4.13. Auto-reloading Changed Files

Wing’s editor detects when files have been changed outside of the IDE and can reload
files automatically, or after prompting you for permission. This is useful when working
with an external editor, or when using code generation tools that rewrite files.

Wing’s default behavior is to automatically reload externally changed files that you have
not yet been changed within Wing’s source editor, and to prompt to reload files that
have also been changed in the IDE.

You can change these behaviors by setting the value of the Reload when Unchanged
and Reload when Changed preferences

On Windows, Wing uses a signal from the OS to detect changes so notification or reload
is usually instant. On Linux and Unix, Wing polls the disk by default every 3 seconds;
this frequency can be changed with the External Check Freq preference.

4.14. Search/Replace

Wing provides a number of tools for search and replace in your source code. Which you
use depends on the complexity of your search or replace task and what style of searching
you are most familiar with.

4.14.1. Toolbar Quick Search

One way to do simple searches is to enter text in the search area of the toolbar. This
scrolls as you type to the next match found after the current cursor position. Pressing



73

Enter will search for each subsequent match, wrapping the search when the end of the
file is reached.

Text matching during toolbar quick search is case-insensitive unless you enter a capital
letter as part of your search string.

If focus is off the toolbar search area and it already contains a search string, clicking on
it will immediately start searching in the current source editor for the next match. If
you wish to search for another string instead, delete the text and type the desired search
string. As you delete, the match position in the editor will proceed backward until it
reaches your original search start position, so that after typing your new search string
you will be presented with the first match after the original source editor cursor position.

4.14.2. Keyboard-driven Mini-Search/Replace

The Edit menu contains a Mini-Search sub-menu that enumerates the available
keyboard-driven search options. These are normally initiated with the keyboard com-
mand sequences shown in the menu and can be controlled entirely by using the keyboard.
All interaction with the mini-search manager occurs using data entry areas displayed on
demand at the bottom of the IDE window.

The implementation of the mini-search manager is very close to the most commonly
used search and replace features found in Emacs, but it is available whether or not the
Emacs editor personality is being used.

The following search and replace features are available in this facility:

e Forward and Backward -- These display a search string entry area at the bottom
of the IDE window and interactively search forward or backward in the current
source editor, starting from the current cursor position. The search takes place as
you type and can be aborted with Esc or Ctrl-G, which returns the editor to its
original cursor location and scroll position.

Searching is case-insensitive unless you enter a capital letter as part of your search
string. To search repeatedly, press Ctrl-U (Ctrl-S in emacs keyboard mode)
to search forward and ‘‘Ctrl-Shift-U (Ctrl-R in emacs mode) to search in
reverse. The search direction can be changed any number of times and searching
will wrap whenever the top or bottom of the file is reached. You can also enter
Ctrl-U (Ctrl-Sin emacs mode) or Ctrl-Shift-U (Ctrl-R in emacs mode) initially
while the search string is still blank in order to call up the most recently used search
string and begin searching forward or backward with it.

e Selection Forward and Selection Backward -- These work like the above but
start with the selection in the current source editor.
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e Regex Forward and Regex Backward -- These work like the above but treat
the search string as a regular expression.

e Query/Replace and Regex Query/Replace -- This prompts for search and
replace strings in an entry area at the bottom of the IDE window and prompts
for replace on each individual match found after the cursor location in the current
source editor. Press y to replace or n to skip a match and move on to the next
one. The interaction can be canceled at any time with Esc or -G. Matching is case
insensitive unless a capital letter is entered as part of the search string. Searching
is always forward and stops when the end of the file is reached, without wrapping
to any un-searched parts between the top of the file and the position from which
the search was started.

e Replace String and Replace Regex -- This works like the above command but
immediately replaces all matches without prompting.

4.14.3. Search Tool

The dockable Search tool can be used for more advanced search and replace tasks on
the current editor. It provides the ability to customize case sensitivity and whole/part
word matching, search in selection, and perform wildcard or regex search and replace.

To the right of the Search and Replace fields, Wing makes available a popup that
contains a history of previously used strings, options for inserting special characters,
and an option for expanding the size of the entry area.

The following search options can be selected from the tool:
e Case Sensitive -- Check this option to show only exact matches of upper and
lower case letters in the search string.

e Whole Words - Check this option to require that matches are surrounded by
white space (spaces, tabs, or line ends).

e In Selection -- Search for matches only within the current selection on the editor.
The following additional options are available from the Options popup menu:

e Show Replace -- Whether or not the Replace fields are visible on the tool.
e Text Search -- Select this to do a regular text search without wildcard or regex.

e Wildcard Search -- Select this to allow use of special characters for wildcarding
in the search string (see below for details).
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e Regex Search -- Select this to use regular expression style searching. This is a
more powerful variant than wildcard search that allows for more complex specifi-
cation of search matches and replacement values. For information on the syntax
allowed for the search and replace strings, see Python’s Regular Expression Syntax
documentation.

e Wrap Search -- Uncheck this to avoid wrapping around when the search reaches
the top or bottom of a file.

e Incremental -- Check this to immediately start or restarted searching as you
type or alter search options. When unchecked, use the forward/backward search
buttons to initiate searching.

e Find After Replace -- Select this to automatically find the next search match
after each Replace operation.

Wildcard Search Syntax

* can be used to match any sequence of characters except for line endings. For example,
the search string my*value would match anything within a single line of text starting
with my and ending with value. Note that * is “greedy” in that myinstancevalue =
myothervalue would match as a whole rather than as two matches. To avoid this, use
Regex Search instead with .*7 instead of *.

? can be used to match any single character except for line endings. For example,
my???7value would match any string starting with my followed by three characters, and
ending with value.

[ and ] can be used to indicate sets of match characters. For example [abcd] matches
any one of a, b, ¢, or d. Also, [a-zA-Z] matches any letter in the range from a to z
(inclusive), either lower case or uppercase. Note that case specifications in character
ranges will be ignored unless the Case Sensitive option described above is turned on.

4.14.4. Search in Files Tool

The dockable Search in Files tools is